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Introduction to WorkExpo

2.1 Delete Sample Records
You can delete the sample records in WorkExpo even if you have added your own records:
1. Make sure that you have a good backup of your data file.
2. In the Main Menu - from the menu bar at the top of screen choose Tools / Utilities /Delete sample records
This option removes the sample student and employer records but does not delete any other records.

2.2 School Details
On the School Details page you can enter the school details for your school or college. Enter the address details for
the school, indicate what the public liability is and Principal name and Title. These details will appear on letters
generated by WorkExpo.
Add/Edit/Delete WorkExpo Users:
In previous versions of WorkExpo the school phone numbers were stored with the school details. With the
introduction of multiple-users in WorkExpo these details are now stored on a user-by-user basis.
To add/edit or delete school phone, fax and email details:
1. From the WorkExpo main menu click the large Options button.
2. In the school details section choose Add/Edit/Delete WorkExpo users
3. Add or edit the details for each WorkExpo user.
The phone, fax, mobile phone and email for the logged-in user will appear in all documents and letters.
How to add a password for a particular user:
1. Log into WorkExpo as the user you wish to set a password for.
Note that you can Log Off and change users without having to close WorkExpo. To do this choose Log Off
from the File Menu.
2. From the WorkExpo main menu click the large Options button.
3. In the Options dialog click the Password tab.
4. Add or edit the password for the logged-in WorkExpo user.
Next time WorkExpo starts you will be prompted for a password.
You can add up to 5 users if you have a network licence.

2.3 How to Register WorkExpo
In WorkExpo you do not need to register nor unlock the software.
WorkExpo uses the name of the school as the unlock device. Please ensure you enter the school name correctly.
If you have installed the WorkExpo in demo mode there is no need to re-install the software.
You can turn the demo into a full working version. Follow these steps:
1. Start WorkExpo and click the OPTIONS button on the main menu.
2. In the SCHOOL DETAILS tab, make sure that your school name is correctly entered.
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3. If you have a current subscription the software is registered.
Ensure that the school name is entered correctly before attempting to register.
If you have already registered and are trying to change the name of the school this is possible only by
contacting Info Plan Software on (03) 9531 1091

©2020 Info Plan Software. All Rights Reserved.
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2.4 Understanding The WorkExpo Database Structure
Notes about the DATA.MDB file
All the information that you enter into WorkExpo is stored in a single data file. This file’s default name is
DATA.mdb (although you can name it anything you like) and it normally resides in the C: \Program
Files\WorkExpo folder. This file contains all your important WorkExpo information and should be carefully
backed-up regularly. Always back-up the data file after each session.
Back-up strategies
WorkExpo will create a backup copy of your data file when you exit the program. To ensure this select OPTIONS,
then Backup maintenance.
It's a good idea to have two copies of your data file in case one is lost or unusable.
You should have a backup copy of your data file on floppy as well as a separate backup copy on the hard drive or
preferably on the network.
You can open data files directly in WorkExpo. Follow these instructions to do so:
1. In WorkExpo select OPEN from the FILE menu.
2. Navigate to the data file you wish to use.
3. The default file DATA.MDB normally resides in C:\Program Files\WorkExpo or wherever you store the
WorkExpo data file.
How to copy a WorkExpo data file from one computer to another
1.
2.
3.
4.

Make sure WorkExpo is closed.
Use Windows Explorer to copy the file DATA.MDB to a floppy disk.
Place the floppy disk in the drive of the second computer.
Use Windows Explorer to copy the file DATA.MDB to C:\Program Files\WorkExpo or wherever you store the
WorkExpo data file

The path to the data file you're using can be displayed in the title bar. Select OPTIONS/Settings to set this.

2.5 Single Or Multi User Subscription?
You can purchase WorkExpo with a single-user subscription or a two to six user subscription.
You should purchase a single-user subscription if:
You are the only person in your school, college or campus who uses WorkExpo AND
You are using WorkExpo on a stand-alone PC.
A single-user subscription entitles you to install WorkExpo on one desktop PC and you may also install a copy of
WorkExpo on your notebook or laptop PC. You may move the data file to a network drive for security reasons but
you are not able to share the data file across the network with other users.
You should have a multi-user subscription if:
There is or are other staff member(s) who wish to have access to or use WorkExpo on their own PC OR
You need to install WorkExpo on more than one desktop PC for use across a network OR
You are job sharing with another staff member and you both are using WorkExpo.
A multi-user subscription is required if WorkExpo is installed on a single machine but two (or more)
people use it. Note that you can select from a 1 - 6 user subscription.

2.5.1

Multi-School or Multi-Campus version:
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A special Multi-School edition of WorkExpo is available for teachers arranging work experience across more than
one school. This edition allows students to be grouped by school in lists and reports.
A multi-user subscription allows for up to 6 (six) users. Each user may install a copy of WorkExpo on their
desktop PC and another copy on their notebook PC.
A single-user subscription entitles the user to install a copy on their desktop machine and a laptop for their
own use.
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9

Getting Started

3.1 WorkExpo in a nutshell
In simple terms there are three basics steps to creating a new student arrangement record within WorkExpo.

Add a new student record in the Students window:

Add a new record for an Employer.

Finally, create the Arrangement between the student and employer

Some things to be aware of when adding records in WorkExpo
Records are saved automatically but you can explicitly save a record by pressing the save button on the
toolbar.
These three windows are the central work areas in WorkExpo and where you spend most time in
WorkExpo.
It's important to understand that deleting an arrangement record DOES NOT delete the related student or

©2020 Info Plan Software. All Rights Reserved.

WorkExpo User Manual

10

employer records.
A student may have more than one arrangement.
An employer may have more than one student undertaking work experience at the same time.

3.2 Adding New Student Records
To add a new student record manually:
1. In the Students window.
2. Select EDIT then Add new student from the menu or click the STAR button on the WorkExpo ToolBar.
3. Once you have added the details, the new record is saved when you move off the record or when
the Save button on the toolbar is clicked.
To delete a student record:
1. In the Students window.
2. Select 'Delete student record' from the EDIT menu.
3. The currently displayed student record will be deleted.
4. If the student has any placements these are also deleted. WorkExpo will warn you if this is the case.

When you delete a student or employer record all arrangements and all other details associated with that
student or employer are also deleted. WorkExpo will always you of this.

3.3 Add New Employer
To add a new employer record manually:
1. In the employer window.
2. Select "EDIT" then "Add new employer" from the menu or click the STAR button on the WorkExpo ToolBar.
3. Once you have added the details, the new record is saved automatically or you can click the save record
button on the toolbar.
To delete a employer record:
1. In the employer window.
2. Select "Delete employer record" from the EDIT menu.
3. The currently displayed employer record will be deleted.
4. The employer record is deleted.
Notes:
You can import employer records into WorkExpo from many external sources.
You can delete sample employer records easily. See Delete Sample Records (Section 2.1)
You can delete multiple employers with just a few clicks. See Deleting Employer records (Section 6.6).

3.4 Create New Arrangement
The student and employer must already exist in WorkExpo before an arrangement can be created.
In the student or employer does not current exist then they will need to be added via the student or
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employer screens.
To create a new arrangement in WorkExpo:
1.
2.
3.
4.
5.
6.
7.
8.
9.

From the WorkExpo main menu click the Arrangements button.
In the Arrangements window click the large NEW button at the top left of screen.
A new (empty) arrangement record is created and ready for input.
Place the cursor in the Student field and type the first few letters of the student's last name.
WorkExpo finds the student and populates the field.
Press the tab key on the keyboard. WorkExpo moves to the Employer field.
Enter the first few letters of the employer name and press tab.
Continue to complete the fields in the Arrangements window in this way.
Once the record has been entered click the Save button on the toolbar or move off the record to another
record.

The minimum fields are student, employer, start date, end date and work type.

3.5 Setting fonts and font sizes in letters
When setting up letters in WorkExpo you are able to choose fonts and/or font sizes. Certificates, reports. proformas and lists continue to use WorkExpo font defaults.
Follow these instructions to set up fonts and font sizes for all letters.
1.
2.
3.
4.

From the WorkExpo Main Menu click the large Options button
Click the Print Settings tab
Click the Set Fonts For Letters blue hyperlink
Select the Font and font size as necessary.

The selected font will be used in all letters in WorkExpo.
Notes:
Certificates have built in fonts and can't be changed.
Lists and other internal documents have built in fonts and can't be changed.
The default font for WorkExpo letters is Times New Roman size 12.

3.6 WorkExpo Options
WorkExpo is very customizable and offers many options and settings so that you can spend the minimum time with
data entry and the maximum time with analysis and outputs.
The following is a list of items or features which offer customization within the program including:
Setting the date which appears on letters
Setting up your own user-defined fields
Maintaining Work Type pick lists
Setting passwords for multiple users
Configuring warnings while you are working
Using an ink-jet printer
Show or Hide the School Details information in letters
Set up your own custom letters
Using signature images in letters
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Warning you of various errors or possible conflicts while you work.
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Tutorials

4.1 Default Dates
In the Arrangements window you can set a default start date and a default end date so that each newly created
arrangement record has the start date and end date filled in with your current block dates as defaults.
To set a default start date and a default end date for each new placement:
1. In the Arrangements window click the OPTIONS tab in the upper right of screen.
2. In the section Defaults for each new Arrangement enter the start and end date you'd like each new
arrangement to default to.
3. You can double-click these date fields to pop-up a calendar. Choose a date from the calendar and click it and
the selected date will appear back in the Arrangements window's default date box.
To edit the dates which appear in the start and end date drop down boxes perform the following:
1. In the Arrangements window, click the large DATES button at the lower left of screen.
2. This pops up the dates edit dialog box where you can add, edit or delete a series of start and end dates.
It is recommended that you enter all possible start and end dates which may occur during the year so that you can
easily select a particular start date or end date from the drop down boxes. For example, if you have a two week block
for work experience you should enter BOTH Monday dates as possible start dates and BOTH Friday dates as
possible end dates. This will mean that when you are entering arrangement records for students undertaking oneweek placements you will have the start and end dates readily available from the drop down boxes.

4.2 Postcodes
WorkExpo is designed primarily for Australian schools. In both the student and employer windows there's an
automatic postcode lookup feature. This feature allows you to type a suburb name and WorkExpo finds the
postcode and populates the postcode field automatically. You can specify which state to use by double-clicking in the
Suburb field. When you do this a postcode selection dialog box is displayed. You can choose any combination of
Australia postcodes or choose to disable the automatic postcode lookup feature altogether. WorkExpo will
remember your settings for future.
How to set specific state postcode lookup:
1.
2.
3.
4.

In the students or employers window double-click the Suburb field.
The postcode lookup dialog box is displayed.
Click to include or exclude any combination of States/Territories.
Optionally, you can select "Don't use Auto Postcode" and the feature is disabled.

The postcode list cannot be edited. It is updated with each new version of WorkExpo.
You can choose multiple states and the postcode lookup will shows all state postcodes selected.
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WorkExpo User Manual

14

4.3 Using School Logo in Certificates
You can use your school logo in certificates and letters in WorkExpo. The logo must be an image file (.bmp or jpg).
Prepare the image file before adding it to WorkExpo and note the file location of the file. Try to keep the file size as
small as possible.
To add a logo to a certificate, first bring the certificate up in print preview.
To display a certificate in print preview mode:
1.
2.
3.
4.
5.

From the WorkExpo main menu click the Print button to start the Print wizard.
Choose Students / Individual Student then click Next.
Select any student with a placement from the list and click Next.
Place a tick in the Student Certificate box.
Make sure that Print Preview is selected in options for print.

The certificate is displayed in print preview mode.
To include a school logo with the certificate:
1. Click the School Logo button on the Print Preview toolbar.
2. This displays the School Logo settings dialog box.
3. Here is where you set properties for the logo.
There are two certificates in WorkExpo, one for students and one for employers. Each Certificate can have its own
logo. Therefore you need to add the logo to each certificate.
Property settings for formatting school logo: - See also Setting Up Logo ('Setting Up Logo On Page'
in the on-line documentation)
Property

Description

Logo visible

Make the logo visible or invisible

Logo file path

Path to the logo bitmap image file. Click to browse.

Logo align

Align logo left, centre or right of page.

Logo top

Logo distance from the top margin in centimeters.

Logo mode

Image mode - defaults to Best Fit.

Text top

Text distance from the top margin in centimeters.

Show school

Include the school name in certificate.

Show border

Include a border around the certificate.

Teacher name

Include the current logged-in user's name.

Teacher title

Include the current logged-in user's title.

Teacher sig

Include the current logged-in user's signature.

Principal name

Include the school principal's name.

Principal title

Include the school principal's title.

Principal sig

Include the school principal's signature.

Extra Page Depth

Makes the page longer but can create a second page.
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Notes:
WorkExpo will remember your logo settings from session to session.
Each Certificate can have its own logo. Therefore you need to add the logo to each certificate.
You can set the margins for the certificate by choosing File / Page Setup when in print preview.
You have can different settings and/or different logos for the student certificate, employer certificate and
letters.
Image formats supported .bmp or jpg are supported.
You can turn logos on globally from Options / Print Settings but the settings you make in print preview
override these.
Be careful using the Extra Page Depth setting as it can create too much space at the bottom of the page an
extra blank page may be created.

Teacher and Principal signatures are added in Main Menu /Options / Signatures

4.4 Using School Logos in Letters
You can use your school logo in certificates and letters in WorkExpo. The logo must be an image file (.bmp, .gif, .jpg
or .png).
Prepare the image file before adding it to WorkExpo and note the location of the file. Try to keep the file size as small
as possible.
To add a logo to a letter, first display the document in print preview.
To display a letter in print preview mode:
1.
2.
3.
4.
5.

From the WorkExpo main menu click the Print button to start the Print wizard.
Choose Students / Individual Student then click Next.
Select any student with a placement from the list and click Next.
Place a tick in one of the letter options e.g. Letter to Employer.
Make sure that Print Preview is selected in options for print.

The letter is displayed in print preview mode.
To include a school logo with the letter:
1. Click the School Logo button on the Print Preview toolbar.
2. This displays the School Logo settings dialog box.
3. Here is where you set properties for the logo.
Property settings for formatting school logo: - See also Setting Up Logo ('Setting Up Logo On Page'
in the on-line documentation)
Property

Description

Logo visible

Make the logo visible or invisible

Logo file path

Path to the logo bitmap image file. Click to browse.

Logo align

Align logo left, centre or right of page.

Logo top

Logo distance from the top margin in centimeters.

Logo mode

Image mode - defaults to Best Fit.
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Text top

Text distance from the top margin in centimeters.

Show school

Include the school name and address at the top.

Teacher name

Include the current logged-in user's name.

Teacher title

Include the current logged-in user's title.

Teacher sig

Include the current logged-in user's signature.

Principal name

Include the school principal's name.

Principal title

Include the school principal's title.

Principal sig

Include the school principal's signature.

Extra Page Depth

Makes the page longer but can create a second page.

16

Notes:
WorkExpo will remember your logo settings from session to session.
Each letter can have its own separate logo. This means that you need to add the logo separately to each
letter.
You can set the margins for the letter by choosing File / Page Setup when in print preview.
You have can different settings and/or different logos for the student certificate, employer certificate and
letters.
Image formats supported are .bmp, .gif, jpg and .png
You can set logos on globally from Options / Print Settings but settings you make in print preview override
these.
Be careful using the Extra Page Depth setting as it can create too much space at the bottom of the page an
extra blank page may be created.
Each letter can have its own separate logo. This means that you need to add the logo separately to each
letter.
Teacher and Principal signatures are added in Main Menu /Options / Signatures

4.5 Assign Teacher Visits
You can assign teachers to visit students on Work placement. You can do this at the time of creating the
arrangement or add this information later.
Follow these instructions to assign teacher visits.
1.
2.
3.
4.

Go to the Arrangements window.
Choose VISITS from the VIEW menu
Select the visiting teacher from a drop down list.
Click the PRINT button on the bottom right to view a hard copy document.

4.6 Creating and Saving Custom Letters
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WorkExpo allows you to write a custom letter to a selected employer and save the custom letter to be re-used later.
You can choose to create new custom letters or edit your own existing custom letters. You can also print custom
letters you have written and saved. Custom letters are designed to allow you to create and saved "one-off" letters e.g.
a Cancellation letter which you might use occasionally. Custom letters can only be sent to employers and they can't
be merged or bulk generated. They are designed to be sent to a single employer at a time.

1.
2.
3.
4.

With the WORKEXPO main menu on your screen click on the PRINT button.
The Print Wizard dialog box will appear. Select “Custom letters to employers” and click NEXT
Follow the steps that WorkExpo walks you through.
Each letter that you write must be given a name which you enter in the Letter Type box while the text is
entered in the Letter Text area.
5. When writing a new letter include only the body text of the letter Do not include
Recipient
Address
Date

WorkExpo will take care of these parts of the letter.

To delete a custom letter press DELETE. The currently displayed letter will be permanently deleted.
Custom letters are designed to be sent to a single employer at a time. You can't add, edit or delete WorkExpo's
in-built letters and documents.

4.7 Using Custom Colors with WorkExpo
In WorkExpo you can set up the main windows so that the color of the Header area changes depending on the
placement status of the current student or employer. This is useful as the change in color gives a visual clue as to the
current state of the placement, When you turn on this color setting you can choose to accept the pre-defined
WorkExpo colors or set your own colors.
Follow these instructions to activate color settings in WorkExpo.
1.
2.
3.
4.
5.
6.

Go to the Arrangements window.
Choose the OPTIONS tab on the right of the screen.
Click the “set colors” link.
The Add/Edit Placement Type.
Add a new Placement Type called VCAL, for example (Victorian Certificate of Applied Learning).
Set colors as preferred using the Windows Color Picker dialog.
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4.8 Using Mail Merge - Overview
MailMail merge - What to do.
Use Microsoft Word's Mail Merge Wizard to create form letters, mailing labels, lists and envelopes for distribution.

1. Data source with recipient information, such as student or employer information
2. Main document with merge fields that are placeholders for WorkExpo information
3. Resulting merged document
Word’s wizard guides you through all of these steps. If you prefer to work outside the wizard, you can use the Mail
Merge toolbar. Either way, the end result is that each row (or record) in the data source produces an individual
form letter, mailing label, envelope, or directory item.
Notes
To complete the basic process, you:
Open or create a main document.
Open or create a data source with individual recipient information.
Add or customize merge fields in the main document.
Merge data from the data source into the main document to create a new, merged document.
You can use Word’s mail merge to create any type of document that maps fields to data, not just mailings
or lists.
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4.9 Email Arrangement Form
You can email the work experience and SWPL arrangement forms (or the Student Placement form in NSW) from
within WorkExpo.
Please note the following points:
1.
2.
3.
4.
5.
6.
7.
8.

You can only send one email at a time for an individual student.
You can send via Outlook, GMail or a remote mail server e.g. Bigpond.
If you send using Microsoft Outlook then before sending you can preview and edit the message.
You can set email preferences and setting from the OPTIONS / MISC tab or directly from Print Preview
window.
The employer the email is to be sent to is displayed at the top of the Email Settings dialog when in Print
Preview.
Only the Arrangement forms can be emailed. However, all other WorkExpo documents and lists can be
saved in PDF format.
If an employer has an additional email address for a postal contact, then the email is sent to the postal
contact and cc'd to the other.
Emails can only be sent in text format.

To send a copy of the Arrangement form attached as a PDF document to an email follow these steps:
Select an individual student from the list in the Print Wizard - Individual Student and click NEXT.

It is important that you select an individual student for email. You cannot select groups of students for email.
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Choose the Arrangement form option for the currently selected student.

and select PREVIEW then click FINISH
The document displays in print preview mode. You will notice the email options on the toolbar. Before you can send
emails for the first time you will need to check your email settings. Click Email Settings on the toolbar.

The Email settings dialog is displayed.
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You will need to configure your preferences for emailing here but you will only need to do this once.
Your name and title as the logged-in user will be displayed. Note that you can only send emails as the logged-in user
and not as the Main Contact for the school. This is due to password security issues.
Here are the settings you can configure:
Email Mode: Select the method or mode by which email messages will be sent from your machine. Select either
'Outlook', 'GMail' or 'Remote Server'. If you select Outlook then your Outlook email client will handle most of the
work and you will be able to preview the email before sending by checking the 'Display Outlook Email Before
Sending' option. You cannot add, edit nor delete entries in this list. These are the only options for email servers in
WorkExpo.
Use Outlook Signature: In Microsoft Outlook you can store your signature text to append at the end of emails.
Select YES and enter the name of your Outlook signature to add to the end of all emails sent.
Use Outlook Name: The name of your Outlook signature. Select from the drop-down box or leave blank. You
should not enter free-form text here. If you want to add a signature do that in Microsoft Outlook first.
Default Subject: The default subject of your email message. If you leave this blank WorkExpo will automatically
create a header containing the Arrangement type, the name of the student and the dates. e.g 'Work Experience - Joe
Bloggs - 12/12/2013 - 22/12/2013'. Alternatively, if you enter your own default subject header, WorkExpo will not
create a header.
Default Body: The default body text of your email message. If you leave this blank WorkExpo will use your default
'Letter To Employer' boilerplate text depending on the Arrangement type for the current student. If you enter your
own default body text, WorkExpo will not create body text.
SMTP Server: The name of the SMTP server to use if you have chosen 'Remote Server' as the email mode. e.g.
mail.bigpond.com
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SMTP User-name: The name of your existing account on the SMTP server. If you do not have an existing account,
then use a different email mode or save the document to PDF format and email manually.
SMTP Password: The name of your existing password on the SMTP server.
GMail Address: The name of your existing Gmail email address, e.g. JoeBloggs@gmail.com
GMail user-name: The name of your existing Gmail user-name, usually your Gmail email address name portion,
e.g. JoeBloggs
Gmail Password: The name of your existing password on Gmail.
Note that you can see the SEND TO email address in the TO: box just below your name in the dialog box
header.

Click to confirm send. If you have checked 'Display before sending' then you can preview the email.
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Click SEND

Only the Arrangement form, the SWPL form and the NSW Placement form can be emailed in this way.
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4.10 Save As PDF
You can save any document in WorkExpo to PDF format including multiple document runs e.g. all current letters to
employers.
Please note the following points:
1. You must print preview the document before saving it.
2. Click the 'Save As PDF' button on the print preview toolbar.
3. Documents are saved to a single PDF file including merge documents containing document for several
students.
4. You can save reports, lists, forms, certificates and letters. In fact you can save anything that displays in print
preview.
5. When you click 'Save As PDF' a browse box is displayed so you can specific the path and name of the PDF
output.
6. You do not need to add the PDF file extension but can if you wish.
7. This feature is not available if you are running versions of Microsoft Office 2003 or earlier.
Select 'Save As PDF' from the print preview toolbar.

4.11 Main School Contact
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This feature first appeared in Version 12 of WorkExpo. If your school has more than one WorkExpo user, you can
nominate a 'Main user' or 'School contact'. This person's name appears on all documents:

This allows you to log into WorkExpo under your own name and title, yet print documents bearing the name and
contact details of another nominated member of staff i.e. the Main contact at the school or college.
For example, in the above sample dialog box, Susan Jones is logged into WorkExpo but all documents will show
Jane Smith's name. This may be useful if you have a multi-user licence for use with WorkExpo and you need to
nominate one contact person at the school, despite several staff using WorkExpo.
To do this, from the Main Menu, click OPTIONS / SCHOOL DETAILS and select the Main contact from the
drop down list of current WorkExpo users.

4.12 Google Maps
This feature first appeared in Version 12 of WorkExpo. You can choose to show Google maps for a current employer
in WorkExpo. You can do this from the Employers screen or the Arrangements screen.
Click the Google Maps icon to display a map of the current employer.
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Click the above icon next to the Employer address and WorkExpo will find the address on GOOGLE MAPS and
open a web browser to show the map.
In Google Maps you can print the map if necessary.
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The Google Map icon is available in WorkExpo adjacent to address fields. Click the icon to view the map of the
address in a web browser.

4.13 Create Custom Documents with Mail Merge Wizard

What to do

Notes
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1. Start Microsoft Word.

We will create a custom Student Certificate using a school logo.

2. Open a blank document if one is
not already open

Choose File/New Document

3. From the Tools menu, select
Mail Merge…

4. The Mail Merge Helper
(Wizard) appears.

5. The Mail Merge Helper has 3
steps

Step 1 is CREATE new document
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6.

Click CREATE

7.

Select Form Letters

8. Next the wizard asks if you’d
like to use the Active Window

29

Form Letters are a way to create a page for every record in our data source.
This means a page for each student record, for example.

Click Active Window
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9. Click the GET DATA button.
This is the second step in the
wizard.
In this step you can create a new
data source or open an existing
data source.
Our WorkExpo data file is our data
source so choose OPEN DATA
SOURCE…

10. Navigate to the WorkExpo
folder.
By default this folder is
C:\PROGRAM
FILES\WORKEXPO
IMPORTANT NOTE!
In the Files of type drop down box
make sure that MS Access
databases is selected!
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11. Word now creates a link to the
Microsoft Access database file and
displays its contents.
Click the Tables tab, then choose
under Tables in data.mdb:
Arrangements for Mail Merge

12. Because the main document is
Click EDIT MAIN DOCUMENT
a new document Word displays this
message.

13. The wizard disappears and we
are returned to the main document

The Mail Merge Toolbar appears
14. Now the mail merge toolbar has We use this toolbar to perform the merge process. Run your mouse over the
appeared.
toolbar buttons to get acquainted with them.
15. Click the INSERT MERGE
FIELD button at the left of the
toolbar.
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The fields from WORKEXPO are displayed in a list. Because there are many fields in WorkExpo this list is very
long. Click on Student_First_Name. Word inserts that field into the Word main document.
16. The field is shown enclosed in
double brackets called
CHEVRONS
17. Press the space bar to create a
space after the inserted field
18. Click the INSERT MERGE
FIELD button at the left of the
toolbar again.

19. This time insert the student’s
last name.

Click on the field called Student_Last_Name

20. To VIEW the data that the
fields represent you click the ABC
button as shown below

This allows you to check that the data in WorkExpo is successfully being merged. You should see a student’s first
and last name instead of the field names. To switch back to the field click the “View Merged Data” button again.
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21. Click the NEXT RECORD
(See above) button to view the
name of the next student.

33

Similar to the Student and Employer navigation controls in WorkExpo.

22. You have now set up your main
document. The next step is to
create the merge itself.
23. Finally the merge itself occurs.
Click the
Merge To New Document
button
(see below)

This creates the third and final file in the merge process.

24. Word now displays the results
of the merge in a new document.

This file can be saved or printed. Alternatively, you can simply click the
“Merge to printer” button to produce the output of the merge directly to the
printer.

25. Save the main document for
later re-use.

This saves all merge information so that next time you won’t need to use the
merge wizard.

26. Check out some of the merge
samples on the CD under the
TRAIN folder.

Or under the My Documents folder.

4.14 Printing Double-sided Arrangement Forms
Double sided arrangement forms are causing some difficulty and paper wastage in some schools.
Teachers have requested that they be able to print the first page only of the work experience arrangement form so
that they can photocopy a single blank Page 2 and print all of page 1 information directly from WorkExpo. Thus
producing a single document for each student.
WorkExpo allows you to print the FIRST PAGE ONLY if required.
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Follow these steps to print a single double sided form for each student:
1.
2.
3.
4.

Photocopy page 2 of your master copy of the Arrangement form.
Feed this photocopy, blank side up, into your printer.
Ensure that “First Page Only” is checked, as shown above.
All arrangement forms printed from WorkExpo will now only ever print the first page.

WorkExpo can print both sides of work experience arrangement form if you are using a duplex printer.

4.15 Transfer data file between Two Computers
You can transfer the WorkExpo data between two computers.

1.
2.
3.
4.
5.

4.16 User Defined Fields
User-defined fields provide a way where you can store information which you determine. You can specify the name
of the field and you can choose whether the field is a text box or a drop down box. If you choose a drop-down box
you can specify default values for the drop-down box. For example, if you added a user-defined field called "Sport"
you could include a drop down box which may contain items such as "Football", "Hockey", "Cricket" etc as possible
choices. You can add up to ten user-defined fields to the Students window and five user-defined fields for employers.
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1.
2.
3.

1.
2.
3.
4.

1. To display field names back on the main student window enter the field names you wish to use here on the
left here.
2. On the REPORT tab you can enter the Name of the Report and a report description.
3.

©2020 Info Plan Software. All Rights Reserved.

35

WorkExpo User Manual
5

36

Students

5.1 Import Student Records - Overview
You can import records into WorkExpo from any external electronic record keeping system. You must, however, do
this as a 2 step process.
Export the required records from your school's database system to an Excel file. Import this file into WorkExpo,
using the Import wizard (File menu)
Select Import Student (or Employer) records. Follow the Import Wizard's instructions on screen.
How to import student records:
1. In WorkExpo, start the import wizard from the File / Import menu.
2. Print the list of fields required in Step 2 of the Import wizard. Then cancel the wizard.
3. Contact your school's central database administrator.
4. Give the field list to the database administrator and request an export file of all Year x records.
5. Request that all fields set out in the field list are included.
6. Open the export file using Microsoft Excel.
7. Format the file as set out in the field list instructions.
8. Once the Excel file has been saved with an .xls extension, re-start the WorkExpo import wizard and follow the
instructions.

You can import student records in a special update import to update records reather than replace them.

5.2 Find Student Records
You can find student records by Last Name or by First Name. You can enter the first few characters of the name
and WorkExpo will try to find a match. For example type in 'SAR' and WorkExpo will locate, for example, 'SARAH'
or 'SARA'. WorkExpo sorts the records into Last Name order if you search by last name and first name order if you
search by first name. This means that if the first record found is not the one you're looking for you can page through
the records using the PAGE DOWN key.
1.
2.
3.
4.
5.

In the Students window, select the MAIN tab.
Choose to search by Last Name or by First Name by selecting the appropriate check box.
Enter the Name of the Student and press enter.
WorkExpo finds the student and shows the student record.
Press the PAGE DOWN key to see the next closest match.

You can also Find Students by using the FIND tool (Section 5.17) e.g. Find students where the post code
= '1234'.

5.3 Sorting student records
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Sort student records by FIRST
NAME and filter student records
for Year 10A students only.

Then remove filtering and sorting
by choosing remove filter/sort from
RECORDS menu.

Right click for shortcut menu

5.4 Optional Tabs
In the students and employers window you can show or hide additional information for students/employers.
This information is available on tabs which either are displayed or hidden depending on your choices in the Options
tab. In this way WorkExpo allows you to hide any information which is not essential to the running of your program.
Settings for optional student information:
Tab name

Description

DETAIL

Provides a DETAIL tab which shows detailed information
for the current student. Fields such as gender and
language spoken at home are available. To make this tab
visible place a tick in the DETAIL check box.
See Setting Defaults ('Defaults - Student
Background Detail' in the on-line documentation)
for students.

PREFERENCE

Displays a tab PREFER where students can indicate a
preference for work experience. WorkExpo will try to
match individual student preferences with employers.
See Student Preferences (Section 5.10)

TRACK

Displays TWO tabs called TRACK. On the left side of
screen the TRACK tab is used to capture information
relating to tracking a student's progress towards work
placement. The other TRACK tab on the right of screen
provides a matrix where tracking outcomes are visible.
See Tracking Overview (Section 5.13).

COUNSEL

Provides a tab where you can capture counselling
information about students. Each counselling interaction
can be captured to provide a counselling history on a
student-by student basis.
See Counselling students (Section 5.11)

USER DEFINED

A tab where you can enter your own user defined fields
(Section 4.16).
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When tabs are hidden the information is not deleted only hidden.

5.5 Setting Defaults
You can set defaults in WorkExpo so that when new records are added certain fields you nominate are automatically
populated with default values. i.e. the gender field is automatically populated as 'female'.
To set defaults for student records in WorkExpo:
1.
2.
3.
4.
5.

From the WorkExpo main menu press the large Students button.
In the Students window click the 'Background Details' tab.
Click the 'Set Defaults' blue link at the bottom of the tab.
In the 'Set Defaults' dialog box, select the defaults you'd like to set and press OK.
Now, when new students records are added these defaults will be added to the new records.

To update existing student records with defaults:
1.
2.
3.
4.
5.
6.

From the WorkExpo main menu press the large Students button.
In the Students window click the 'Background Details' tab
Click the 'Set Defaults' blue link at the bottom of the tab.
In the 'Set Defaults' dialog box, select the defaults you'd like to set.
In the 'Apply Defaults for' section choose 'All Students'.
In the 'Overwrite?' section choosing Yes will overwrite any existing information.

Note: If you choose "Overwrite YES" then any existing values for all students will be overwritten with the new
defaults. If you choose "Overwrite NO" then only student records with empty values for the default fields will
be populated.

5.6 Student Detail (Background) Information
WorkExpo allows you to capture additional details about students. The Detail tab allows you to add additional
detailed information about students. You can include details such as gender, your school’s student ID number and
many other aspects of a student's background details.
Detailed information for students may be useful if you require statistical information about your work placement
program.
For example, you can provide statistics on:
students by placement by gender or
students by country of birth
This information is also included in each student’s detailed individual report.
(In the Students window choose File / Print / Full Details)

5.7 Student Medical And Emergency Information
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1.
2.
NOTES:
Medical information is private not published. This means that it will not appear on any printed
documentation that WorkExpo generates.
There's an option in the Arrangements window to remind you when placing a student with a medical issue.
See the Options tab in the Arrangements window. WorkExpo will remind you of a student's medical
condition when you are creating a placement for that student.

5.8 Delete All Student Records
To delete ALL student records:
1. In the Students window.
2. From the Tools / Utilities menu.
3. Select Delete ALL student records.
4. WorkExpo will ask you to confirm your choice to delete ALL student records.
5. If you proceed, all student records (and all related arrangement records) will be deleted.
NOTE that you cannot undo this operation. Ensure that you have a good backup copy of the data file before you
proceed.

When you choose to delete all student records then all arrangements will also be deleted.
WorkExpo will always warn you of this before deleting any records.

5.9 Students Under 15
You can view a list of all students who are under 15 years of age. The list uses the current computer date to
determine if students are under 15. Alternatively you can enter a date to see what age these students will be on
that date. The list can be printed.
In Victoria, there are certain requirements for students under the age of 15.
For details of these requirements visit the Victorian Government website
Criminal Record Checks are required for Employers & Supervisors of students under 15.
A Victoria Police form is needed only when applying to Industrial Relations Victoria for a Child Employment Permit.
See: Victoria Police - Police Records Checks (http://www.police.vic.gov.au/content.asp?Document_ID=274).
There is no change for criminal record checks handled through the Australian Government, you should continue to
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use the government form,
see: Consent to Check and Release National Police Record form (PDF - 152Kb)
For more information, also see:
Ministerial Order 56 - Work Experience Arrangements (Word - 120Kb)
Circular 158/2008 New Ministerial Orders and Arrangement Forms for Work Experience and Structured
Workplace Learning (Word - 58Kb)
Frequently Asked Questions on Criminal Record Checks (Word - 38Kb)
School Guidelines to Criminal Record Checks (Word - 74Kb) - includes letter to Victoria Police
Risk Assessment Form (Word - 71Kb) - includes a completed sample form.

5.10 Student Preferences
In WorkExpo you can capture information relating to preferences students may have for work experience. Students
can express up to three preferences for work experience.
When working with a student record in WorkExpo you will be able to see which preferences a student has for work
experience. While browsing student records WorkExpo will try to find possible matches with employers who offer
these types of work experience and display a list of matches. For example, if a student expresses a preference for
Journalism, then WorkExpo will display a list of all employers who offer Journalism in the student's record.
HOW TO ENTER STUDENT PREFERENCES FOR WORK EXPERIENCE
In the Students window click the "Preference" tab
Select the student's first preference for work experience in the first box.
Make sure that the "Search Now" check box is ticked. Although you can tick it later.
WorkExpo will display a list of potential matches.
SORT AND GROUP STUDENT PREFERENCES
In the Students window click the "Preference" tab
Select the blue Sort And Group Student Preferences link.
The Sort and Group Student Preferences dialog is displayed.
WorkExpo displays a list of student preferences in a Datasheet grid.
To sort the Datasheet grid:
1.
2.
3.
4.

Place the cursor in the column you'd like to sort on
Right click for the shortcut menu
Choose sort ASC or DESC
The Datasheet is now sorted by the selected field.

To filter the Datasheet grid:
1.
2.
3.
4.

Place the cursor in the column you'd like to sort on
Right click for the shortcut menu
Choose sort Filter By Selection
The Datasheet is now filtered by the selected field value.

OR use the options in the drop down box at the top of screen.
To print the Datasheet grid:
1. Sort and/or filter the Datasheet as necessary
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2. Click the Print button
3. If your settings are set to Print Preview the report will show first in preview.
To copy the Datasheet grid:
1. With the Datasheet grid on screen, press CTRL + A to select all
2. Open Microsoft Excel
3. Choose Edit / Paste to paste the contents into Excel.

5.11 Counselling Students
The Counsel tab in the Student’s window provides a way to capture an individual student’s counselling history.
You can log each interaction with an individual student including things like counselling sessions, attendance at
careers nights, attendance at lectures or to hear guest speakers, work related excursions etc. These counselling
records form part of a student’s overall individual pathways plan and also provide evidence of the part you have
played in counselling and providing for students.
Each student may have multiple counselling records. Each counselling record can include the following:
The TYPE of counselling provided. e.g. one-on-one, information provision.
The date counselling was provided.
Details of the counselling provided.
Who provided the counselling.
A private field determines whether or not the specific counselling detail record is published. If private is ticked it
becomes a private counselling record, which you can access on your computer but will not be included in any printed
reports.
Batch Update Wizard:
You can update multiple student records simultaneously using the Batch Update wizard. For example, if several
students have attended a Careers Night you could update several students records in a single operation, thus saving
tedious data entry on a student-by-student basis.
Click the Batch Update Wizard button and enter the details requested by the wizard. The Batch update wizard
allows you to update multiple student records simultaneously. You can use the Batch Update wizard to update:
Student counselling records OR
Student Exit details OR
Student default details

Note that student counselling records are separate multiple records. A student may have multiple counselling
records against their name. The Exit details, however, are simply additional fields against a student record.
This means that while a student may have many counselling records, each student may only have a single set
of Exit details.

5.12 Exit Students
You can capture information in relation to students who have left or are leaving school.
These 'Exit students' can be followed up at a later date in relation to destinations post-school and exit patterns can
be established.
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To capture information about Exit students:
1.
2.
3.
4.

In the Students window click the Options tab at top right of screen.
Make sure there's a tick next to "EXIT - Capture details of school leaving...".
This displays an EXIT tab in the student details area.
Add information regarding the Exit student here.

To print information about Exit Students:
1. Click the PRINT button on the Main Menu.
2. Choose Other Lists / EXIT Students lists.
To see statistics about EXIT students:
1.
2.
3.
4.

Click the PRINT button on the Main Menu.
Choose Miscellaneous / Program Statistics.
In the Program Statistics dialog choose EXIT Students.
Select the statistic you like figures for from the drop down list.

To view a list on screen about Exit Students:
1. In the Students window choose the VIEW menu option.
2. Next choose View Exit Students...
3. In the View Exit Students grid choose options as necessary.

Note: In WorkExpo a student is an Exit student when they have an Exit Date assigned to them.

5.13 Tracking Students
You can track a student's progress towards work experience using a 'checklist' style approach. This may be useful if
you'd like to keep track of how students are progressing with their arrangements for placement.
A student may have more than one placement and WorkExpo allows you to track each of these separately.
To customize the tracking feature:
1.
2.
3.
4.
5.
6.

In the Students window, click the TRACK tab.
Click the Customize button.
Select the number of items you'd like to keep track of from the drop-down list.
Edit the text of each of the items or 'tasks' to track. You can include any text you wish.
Select OK to save your changes or Cancel to undo.
You can change the number of items or the text of these items at any time.

To link tracking with an arrangement:
1.
2.
3.
4.
5.

If a student only has a single placement there is no need to link tracking.
In the Students window, click the TRACK tab.
Click the "Link to Arrangement" blue link.
A drop down box appear at the top of the tracking list. Any arrangements the student has will appear here.
Select the arrangement from the drop down box you'd like to associate with this tracking record - if more
than one.
6. This tracking record is now linked to this arrangement.
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To UNlink tracking with an arrangement:
1.
2.
3.
4.
5.

In the Students window, click the Track tab.
Select the student with a tracking record linked to an arrangement.
Click the delete hyperlink (blue) to delete the tracking record.
A new empty, unlinked record replaces the previously linked record.
This tracking record is now UNlinked to any arrangement.

To add a new tracking record for a student:
1. In the Students window, click the Track tab.
2. Click the "New" button (looks like a star) on the navigation set of buttons at the bottom of the tracking
items.
3. A new tracking record is now created for the active student.
4. You can assign this new tracking record with a placement (see above).
To delete a tracking record for a student:
1. In the Students window, click the Track tab.
2. Select the tracking record you wish to delete by using the tracking navigation buttons at the bottom of the
tracking record.
3. Click the "Delete" blue link.
4. The current tracking record is now deleted.

Notes:
When you add multiple tracking records for a student, the student will appear multiple times in the
tracking matrix window.
You can assign a placement (arrangement) to a tracking record if you wish but this is optional.
A student may have an unlimited number of tracking records.
Try to avoid confusion between the tracking navigation buttons and the student navigation buttons which
are identical. Note the student navigation buttons are at the very bottom left corner of screen at all times.
You can view the outputs for tracking by using the track tab on the right side of the students window. This
is called the tracking matrix (on-line documentation).

5.14 Customize Tracking
In the Customize Tracking dialog you can do the following:
Choose the number of tracking items (From 1 - 6)
Determine the text for each tracking item - thus the task the student must complete.
Reset all tracking ticks for all students back to empty.
Set or change the Header and Footer for the simple Tracking report.
1. Select the number of tracking items you'd like to set by choosing a number 1 -6 from the drop down.
2. Enter text alongside each tracking item describing the task to be completed by the student.
3. Click OK. Note that you can change this at any time.

5.15 Student Optional Tabs
In the students window you can show or hide additional information for students. This information is available
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on tabs which either are displayed or hidden depending on your choices in the Options tab in the students window.
Settings for optional student information:
Option

Description

DETAIL

Provides a DETAIL tab which shows detailed information
for the current student. Fields such as gender and
language spoken at home are available. To make this tab
visible place a tick in the DETAIL check box.
See Setting Defaults ('Defaults - Student
Background Detail' in the on-line documentation)
for students.

PREFER

Displays a tab PREFER where students can indicate a
preference for work experience. WorkExpo will try to
match individual student preferences with employers.
See Student Preferences (Section 5.10)

TRACK

Displays TWO tabs called TRACK. On the left side of
screen the TRACK tab is used to capture information
relating to tracking a student's progress towards work
placement. The other TRACK tab on the right of screen
provides a matrix where tracking outcomes are visible.
See Tracking Overview (Section 5.13).

COUNSEL

Provides a tab where you can capture counselling
information about students. Each counselling interaction
can be captured to provide a counselling history on a
student-by student basis.
See Counselling students (Section 5.11)

USER DEFINED

A tab where you can enter your own user defined fields
(Section 4.16).

When tabs are hidden the information is not deleted only hidden.

5.16 Form And Home Group Update
WorkExpo uses two different ways to group students - By Year Level or by Homegroup.
If you do want to change it you can do so using the UPDATE tab in the Students window.
This feature allows you to update the Year Level or Home Group for several students at once in a batch operation.
1. From the Main Menu choose Students.
2. On the top right click the 'Update' tab.
3. In the section "What do you want to update?" select either Year or Homegroup.
(Note that you can't update both Year and Homegroup at the same time, but you can update each
sequentially).
4. In the section "Which student records are affected?" you have a choice to include Students in a specific
Year/HG only or ALL students across the entire Year Level or Homegroup.
5. Finally, in the Update section, choose which Year Level or Homegroup you wish to update.
6. In the 'Update To' box enter the new value to replace the one in "Find all Students in".
7. Click 'Update Now' and WorkExpo will perform the batch operation updating all relevant student records.
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When WorkExpo was first released the Year Level was the only way to sort and group students. In later
versions a Home Group (HG) field was added. This mean that the Year Level field is best to use if you only
require one way to group students as it was part of the original database design since its inception.

5.17 Find Students Using the Find Tool
You can find a student record by searching for any part of the student name or any search on any other
field in the Student Window. For example, you could find student records where the Suburb = 'SPRINGFIELD'.
1.
2.
3.
4.

In the Students window, choose FIND from the EDIT menu.
Enter the characters you'd like to find and click the FIND button.
WorkExpo finds the first match and displays the found student record.
If this is not the record you were looking for click the FIND NEXT button.

You can use the asterisk wildcard in your search. For example, SAR* will find SARA and SARAH.

5.18 Custom Student Groups
You can create a custom student group and use this group of students for printing and grouping purposes.
For instance, say that there are half a dozen students going out on work experience during an odd week. You could
create a custom student group and print reports just for these few students even though they may be all in different
year levels and/or home-groups.
To create a custom student group:
1. From the WorkExpo main menu click the Options button.
2. In the General tab click Flag or Group Students for Printing.
3. In the Custom Student Group dialog you can add or remove students from the group.
Click the custom student button to choose to print or group students by custom group when printing.

Only students with arrangements can be members of a custom group.
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Employers

6.1 Find Employer By Business Name
You can find an Employer by Name or by *PART* of the employer or business name. You can enter the first few
characters and WorkExpo will try to find a match. For example type in 'COMM' and WorkExpo will locate, for
example, 'Commonwealth Bank'.
1. In the Employers window, select the GENERAL tab.
2. Enter the Name of the Employer and press enter.
3. WorkExpo finds the employer and shows the employer record in the list.
OTHER WAYS TO FIND EMPLOYERS:
You can also Search Employers by Work Type (Section 6.2) to find a list of employers who offer a
particular type of work.
You can also Search Employers by Key Word (Section 6.3) e.g. BANK to find all employers with
"Bank" in the business name.
You can also Find Employers by using the FIND tool ('Find Employer Using the Find Tool' in the
on-line documentation) e.g. Find employers where the contact first name is "Robert".

6.2 Search Employers By Work Type
You can find an employer by Work Type. Searching this way allows you to view a listing of all employers who offer
a particular type of work, e.g. photography.
1.
2.
3.
4.

In the Employers window, select the LIST tab.
Select the work type from the drop down list.
WorkExpo finds matching employers who offer this work and displays a list of employer names.
Click on any name to view the employer detail record.

OTHER WAYS TO FIND EMPLOYERS:
You can find an employer by Name (Section 6.1) to find an employer by business name or the first part
of the business name.
You can also Search Employers by Key Word (Section 6.3) e.g. BANK to find all employers with 'Bank'
in the business name.
You can also Find Employers by using the FIND tool ('Find Employer Using the Find Tool' in the
on-line documentation) e.g. Find employers where the contact first name is 'Robert'.

6.3 Search Employers By Key Word
You can find an employer by Key Word. Searching this way allows you to view a filtered sub-set of your employer
records which contain a <specified> key word in the employer name.
1. In the Employers window, place the cursor in the Business Name field.
2. Right-click the mouse button to show the shortcut menu.
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3. In the shortcut menu choose the 'Filter For' option.
4. Enter your keyword surrounded by asterisks. e.g. *bank*
5. WorkExpo will filter the list of employers to show only those which have the specified keyword in the
business name.
6. To remove the filter, choose 'Remove Filter/Sort' from the records menu.
OTHER WAYS TO FIND EMPLOYERS:
You can find an employer by Name (Section 6.1) to find an employer by business name or the first part
of the business name.
You can also Search Employers by Work Type (Section 6.2) to find a list of employers who offer a
particular type of work.
You can also Find Employers by using the FIND tool ('Find Employer Using the Find Tool' in the
on-line documentation) e.g. Find employers where the contact first name is 'Robert'.

6.4 Searching Using Wildcards
About using wildcard characters to search for partial or matching values
You use wildcard characters as placeholders for other characters when you are specifying a value you want to find
and you:
Know only part of the value.
Want to find values that start with a specific letter or match a certain pattern.
You can use the following characters in the Find and Replace dialog boxes, or in queries, commands, and
expressions, to find such things as field values, records, or file names.
Character Usage Examples:

Character

Usage

Example

*

Matches any number of characters. It can be used as the
first or last character in the character string.

wh* finds what, white, and why

?

Matches any single alphabetic character.

B?ll finds ball, bell, and bill

[]

Matches any single character within the brackets.

B[ae]ll finds ball and bell but not
bill

!

Matches any character not in the brackets.

b[!ae]ll finds bill and bull but not
bell

-

Matches any one of a range of characters. You must
specify the range in ascending order (A to Z, not Z to A).

b[a-c]d finds bad, bbd, and bcd

#

Matches any single numeric character.

1#3 finds 103, 113, 123

Wildcard characters are meant to be used with text data types, although you can sometimes use them
successfully with other data types, such as dates, if you don't change the Regional Settings properties for
these data types.
When using wildcard characters to search for an asterisk (*), question mark (?), number sign (#), opening
bracket ([), or hyphen (-), you must enclose the item you're searching for in brackets. For example, to
search for a question mark, type [?] in the Find dialog box. If you're searching for a hyphen and other
characters simultaneously, place the hyphen before or after all the other characters inside the brackets.
(However, if you have an exclamation point (!) after the opening bracket, place the hyphen after the
exclamation point.) If you're searching for an exclamation point (!) or closing bracket (]), you don't need to
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enclose it in brackets.
You can't search for the opening and closing brackets ([ ]) together because WorkExpo interprets this
combination nothing.

6.5 Multiple Placements
It is not unusual for a student to undertake more than one work experience placement. You can filter the student list
in the Student screen to view a list of students with multiple placements.

Select the list tab in the Students screen to view a list of students with multiple placements.
You can select 'More Detail' to view additional fields for students with multiple placements and print this list by
clicking the Print button. You can also select 'Export To Excel' to send the list of students with multiple placements
to Excel for ad-hoc reporting.
Click the blue hyperlink 'View More Detailed List' to see a pop-up list showing additional details. Placement details
can optionally be included by selecting 'Include Placement Details'.

The same functionality is also available for employer records. In the Employers screen on the List tab,
select 'Employers With Multiple Placements'.
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You may also view similar list options in the Arrangements screen and print and/or export multiple-placement lists
to Excel from the Arrangements screen.

Your notes here:

6.6 Delete Employer Records
There are different methods you can use to delete employer records.
Method 1: Delete a single employer record.
In the employers window navigate to the employer record you wish to delete.
1. From the Edit menu choose Delete employer.
2. This will delete the employer record and any associated arrangement records.
Method 2: Delete several employer records in a single step.
In the employers window:
1.
2.
3.
4.
5.

From the Edit / Delete menu option choose Delete employer records...
In the Delete Employers wizard select the employers you wish to delete.
You can select multiple employer records for deletion then single-click delete.
Follow the directions in the wizard.
Then click the Delete button.

Method 3: Delete all employer records in a single step.
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In the employers window:
1. From the Edit /Delete menu option choose Delete ALL employers records.
2. Then click the Delete button. This will delete all employers.
3. All employer records and all arrangement records will be deleted.

All associated details e.g. arrangements for deleted employers are also deleted.

6.7 Defaults - Employer Background Detail
You can apply default values to each new employer record in order to save data entry.
Setting Defaults:
You can set defaults for background detail information in the employer window. This saves having to update
individual records if there is likely to be little difference in the values stored for many of your employers.
If you wish to apply defaults that you have set you have three choices:
Apply defaults for the current employer.
Apply defaults for all employers.
Apply defaults only to new records.
Make your selection in the Defaults dialog.
You can set defaults in WorkExpo so that when new records are added certain fields you nominate are automatically
populated with default values.
To set defaults for employer records in WorkExpo:
1.
2.
3.
4.
5.

From the WorkExpo main menu press the large Employers button.
In the Employers window click the Details tab.
Click the "Set Defaults..." blue link at the bottom of the tab.
In the "Set Defaults" dialog box, select the defaults you'd like to set and press OK.
Now, when new employer records are added these defaults will be added to the new records.

To update existing employer records with defaults:
1.
2.
3.
4.
5.
6.

From the WorkExpo main menu press the large Employers button.
In the Employers window click the Details tab
Click the "Set Defaults..." blue link at the bottom of the tab.
In the "Set Defaults" dialog box, select the defaults you'd like to set.
In the "Apply Defaults for.." section choose "All Employers".
In the "Overwrite?" section choose Yes or NO as necessary.

6.8 Industry Sectors
You can add, edit or delete the industry sector descriptions in WorkExpo. Industry sector descriptions are broad
over-arching descriptions of industries and the world of work.
Difference between Work Types and Industry Sector:
Work Types describe the general duties a student might undertake while on work placement e.g.
Receptionist
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Teacher Aide
Aircraft Mechanic
Food Area worker
Industry Sector descriptions are the agreed general broad Industry categories such as:
Manufacturing
Transport & Storage
Finance and Insurance
Hospitality and Tourism
etc.
Both listings within WorkExpo can be edited. Double-click the text box to edit the drop-down list.
To add Industry Sector descriptions to Employers:
1.
2.
3.
4.
5.
6.
7.

At the Main Menu click the EMPLOYERS button.
In the EMPLOYERS window click the DETAILS (Background Details) tab.
You will see that there's an INDUSTRY SECTOR field, drop down the list to view the possible items.
To add/edit or delete items in this list - double-click the INDUSTRY SECTOR field.
To ADD a new item click into the last row and type the item e.g. 'Automotive'.
To DELETE an item select the item by clicking the little grey box at the left of the item.
To EDIT an item simply click into the item and edit. Changes are saved automatically.

You can print arrangement lists by grouped by Work Type or grouped by Industry Sector.
Select Arrangement Lists in the Print Wizard.

6.9 User Defined Fields
Is it possible to change the field names in WorkExpo?
Yes and No. The field names in WorkExpo are generally not customizable. However, the field names in the 'User' tab
(in Student and Employer windows) are customizable.
You can enter your own field names and determine whether the field is a text box or a drop-down box. If you select a
drop down box then you also have control over the items that appear in the drop-down box.
To see what you can do with student user-defined fields try this:
1.
2.
3.
4.
5.
6.
7.
8.
9.

In the Students Window click the Options tab at the top right of screen.
In the Options tab you have control of various optional parameters within the student window.
Place a tick in the User-defined - create your own fields check box.
You will notice that a tab User-defined tab - USER DEFINED
On this tab, click Customize. This displays the user-defined fields dialog where you can edit the properties for
this field.
You can also place a tick in the Use as drop down check box to create a drop down list of possible choices.
If you do this then click the click to set... link. Another dialog appears. Here you can add, edit or delete the
items to appear in your drop-down list.
Click OK. Now back on the User-Defined tab your field names and drop down options should appear as userdefined fields.
You can also change the Tab name from 'User Defined' to something more meaningful.
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In the screen shot below the user-defined tab has been setup to capture sporting information about students.

Use WorkExpo's user-defined fields to capture further information about students or employers.
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Arranging Placements

7.1 Arrangements Datasheet View
You can view Arrangements in DataSheet view from the Arrangements window. Click the View Datasheet icon on
the toolbar and the Datasheet view is displayed.
To sort the Datasheet grid:
1.
2.
3.
4.

Place the cursor in the column you'd like to sort on
Right click for the shortcut menu
Choose sort ASC or DESC
The Datasheet is now sorted by the selected field.

To filter the Datasheet grid:
1.
2.
3.
4.

Place the cursor in the column you'd like to sort on
Right click for the shortcut menu
Choose sort Filter By Selection
The Datasheet is now filtered by the selected field value.

OR use the options in the drop down box at the top of screen.
To print the Datasheet grid:
1. Sort and/or filter the Datasheet as necessary
2. Click the Print button
3. If your settings are set to Print Preview the report will show first in preview.
To copy the Datasheet grid:
1. With the Datasheet grid on screen, press CTRL + A to select all
2. Open Microsoft Excel
3. Choose Edit / Paste to paste the contents into Excel.

7.2 Registered Training Organizations
In the Arrangements window you can enter the registered training organization (RTO) for a student's placement.
On the DETAILS tab in the Arrangements window, drop down the box labelled RTO and select the relevant training
organization from the list.
To Add A New Training Organization
1. Double-click in the RTO field
2. A Pop-up box appears and you can add a new RTO on the bottom row
3. Click OK and the new RTO is now available from the drop-down box as a choice
To EDIT a Training Organization
1. Double-click in the RTO field
2. A Pop-up box appears and you can add a new RTO on the bottom row
3. IN the Pop-up box place the cursor in the row of the RTO you wish to edit.
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4. Double-click the left mouse button.
5. An RTO Edit box is now available. Enter the details of the RTO here.
6. Click OK and the new RTO is now available from the drop-down box as a choice
To DELETE a Training Organization
1.
2.
3.
4.

Double-click in the RTO field
A Pop-up box appears and you can delete any RTO from this list
Select the RTO to delete by clicking the gray box to the left of its name.
Press the DELETE key on the keyboard.
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Multiple Users

8.1 Multiple Users Overview

WorkExpo supports multiple users. For example, several teachers could share WorkExpo with each logging into the
database as a different user. The advantage of this is that each user's name and contact details would appear on
letters to parents and/or employers. You can login and log off from within WorkExpo as well. From the File menu
choose Log Off.
Note that the phone, fax and email numbers are associated with each login user. Edit these phone details from
Options/School/Add,Edit WorkExpo Users.

If there is only one user and that user does not have a password then the login dialog box does not show.

8.2 Add/Edit Users
UsersTo add or edit a user in WorkExpo
From the WorkExpo Main Menu, click the large Options button.
In the school tab, click the link to Add/Edit/Delete WorkExpo users.

The WorkExpo Users dialog box is displayed.

Here you can add, edit or delete WorkExpo users.
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8.3 Delete Users
To delete a user in WorkExpo
From the WorkExpo Main Menu, click the large Options button.
In the school tab, click the link to Add/Edit/Delete WorkExpo users.

The WorkExpo Users dialog box is displayed.

Here you can delete WorkExpo users. Select the user row and press Delete on the keyboard.

8.4 Phone Fax Mobile Numbers
In previous versions of WorkExpo the school phone numbers were stored with the school details. With the
introduction of multiple-users in WorkExpo these details are now stored on a user-by-user basis.
To add/edit or delete school phone, fax and email details:
1. From the WorkExpo main menu click the large Options button.
2. In the school details section choose Add/Edit/Delete WorkExpo Users
3. Add or edit the details for each WorkExpo user.
The phone, fax, mobile phone and email for the loggin-in user will appear in all documents and letters.

8.5 Passwords
8.5.1 Passwords
Passwords allow WorkExpo to be password protected.
To set a password click Options / Password from the Main Menu.

To set or remove a password you must be logged in as the current user.

8.5.2 User Passwords
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To add or remove a user password for a single user in WorkExpo
From the WorkExpo Main Menu, click the large Options button.
Select the Password tab.
Here you can set, change or remove a user password.
How to add or remove a password for multiple users of WorkExpo:
1. Log into WorkExpo as the user you wish to set a password for.
Note that you can Log Off and change users without having to close WorkExpo. To do this choose Log Off
from the File Menu.
2. From the WorkExpo main menu click the large Options button.
3. In the Options dialog click the Password tab.
4. Add or edit the password for the logged-in WorkExpo user.
Next time WorkExpo starts you will be prompted for a password.
You must login as the user you wish to set a password for.

8.5.3 Effective Passwords
Whether your goal is to protect sensitive WorkExpo data — or to keep staff from
reading your personal e-mail — passwords will help. But not just any password will
do. Learn how to create the best type.
Passwords can keep prying eyes from seeing what they shouldn't if you take the time to create strong ones and if
you follow some simple rules of password maintenance. Follow our small business advice and make yourself less
prone to security breaches when running a business or starting a business.
How effective are the passwords you currently use? Ask yourself a few questions to check your current computer
security:

TIP:
You should change your PC password regularly, and Windows XP makes it easy to do. Simply open
User Accounts in the Control Panel and pick the user account where you want to make the
password change. Click on the option to change or reset your password — the wording may vary
depending on which version of Windows XP you use. You can also create a password for your
account if you don't currently use one.

Do I use passwords that someone could easily guess — like my birthday or my child's name?
Do I use common words found in the dictionary for my passwords?
Do I routinely tick the box next to "Remember this password" so I don't have to type them in every
time?
Are my passwords written down where someone might find them?
Do I use the same password for everything?
If you answered yes to any of the questions, the data on your computer is vulnerable. Your passwords are not
working as hard as they could be.
Why Am I Vulnerable?
Here's why the very common password practises noted above put you at risk and what you can do to fix them:
Easy guesses: If someone in your office has access to your computer, it's likely they also know something about

©2020 Info Plan Software. All Rights Reserved.

WorkExpo User Manual

58

you. So avoid using your name or the names of family members or pets as passwords. Avoid using information
that's commonly known or readily available such as your address, birthday or hobby.
Common words: Hackers can use programs that identify passwords based on dictionary words in multiple
languages. Avoid using common words for your password. It is safer to use a combination of letters, numbers and
symbols.
Automated passwords: When you tick the "Remember this password" boxes often encountered on websites,
you'll typically see logon screens pre-populated with dots or asterisks instead of your password when you visit
these sites. This can be dangerous if others have access to your computer. Inexpensive, even free, programs are
readily available that can decode the dots and asterisks. The best option is to avoid using stored passwords, but
either way, make sure your Windows logon is configured with a strong password that you type in each time. That
way, you eliminate the opportunity for someone to snoop around.
Writing passwords down: Passwords are only useful if you can remember them, but writing them down on a
piece of paper and leaving the paper where someone might see it isn't a good alternative either. We'll talk about
ways to create memorable passwords later. But if you have lots of passwords, you might consider storing them in
an encrypted format on your PC. Protect them with a really good password that you'll be able to remember.
Using the same password: Many people use the same password — or some variation of it — for everything.
That reduces the need to remember lots of different passwords. However, it also means if someone figures out
your password once, they can access everything you've password-protected. Not only is it a good idea to have
different passwords, it's also a good idea to change them frequently.
What's a Strong Password?
A strong password will typically have the following characteristics:
It's at least eight characters long — and the longer the better
It includes upper and lower case letters, as well as numbers and symbols
It is changed frequently
A new password is significantly different than the previous one
Based on these criteria, the following are examples of strong passwords:
d&C24!Zp>>l8
*M@a09(b(aTQ
Those passwords would be difficult to crack — but they'd also be difficult to remember, especially if you have a
number of passwords with that level of complexity.
Creating Strong and Memorable Passwords
Computers running Microsoft Windows XP Professional, Windows Small Business Server 2003 as well as Windows
NT and Windows 2000 all support strong passwords. They also support pass phrases, which can be easier to
remember. Examples of pass phrases might be:
I ate (!!) mangoes in Cairns.
3 shoes @ the store cost $92.
Another approach is to select a phrase, but use only the first character of every word. For example:
Ocw13iJ.! (Our cat was 13 in Jan.!)
Mcif&h@17. (My cat is fat & happy @ 17.)
Another trick for creating easy to remember passwords is to string a couple of words together with numbers and
symbols. For instance:
2potatoes+beans$4
cOws@the2ndfArm
There are several ways to make pass phrases easier to remember. Since you'll be changing them every few
months, you might want to look to an upcoming event or something that holds special significance for you. For
instance:
Mum&Dad#25Annivers@ry
ruNNing@Cty2Surf#1teaM
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Once you've created strong passwords or pass phrases, there are three ways to make sure they remain effective:
1. Always log off when you leave your PC unattended
2. Change your passwords at least every 90 days
3. Don't share your passwords with anyone
By putting the power of strong passwords to work, you'll help ensure your confidential information stays that
way.
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Multiple Schools

9.1 Multi-School Edition In Brief
WorkExpo offers a Multi-School Edition. This edition of WorkExpo has all the features of the regular version and
additional features for working with multiple schools. You can purchase the multiple schools edition of WorkExpo or
upgrade to the multiple schools edition. This edition of WorkExpo would typically be used by a Local Learning and
Employment Network (LLENS) rather than a school.
Below is a list of features available in the Multiple Schools Edition
Add/Edit/Delete schools within WorkExpo
View/select students by school in the LIST tab in the Students window
View/select students by school in the Statistics tab of the Arrangements window
You can use the WorkExpo registered school's details or the student's current school details when printing
documents
You can assign individual students to a particular school or assign many students to a particular school
simultaneously.
Provides an option to import a school's specific WorkExpo data file into the current data file. This would
be useful if wanting to merge WorkExpo data files from several different schools into a single large
consolidated data file.
To order or upgrade to the multi-schools edition click here

9.2 Working with Multiple Schools - Overview
WorkExpo Multi Schools (MS) Edition supports multiple schools where students are assigned to different schools.
There is no limit to the number of schools you can add within WorkExpo Multi Schools Edition. When a new school
is added, the new school's address and contact details are also captured. Once the school details have been added
you can assign students as members of the new school. Each student record in WorkExpo must be assigned as a
member of a school. By default students are assigned as members of the default or registered school. The registered
school is the default school or college to which the WorkExpo software is registered.

When you add a new student record you can assign the student as a member of a particular school. If you don't
assign a student, WorkExpo will automatically assign the student as a member of the default registered school.
Student records can be assigned to schools individually or you can assign multiple students to a particular school in
a batch operation, thus saving time.
You can edit or delete existing schools. However, if you want to delete a school record and there are students
currently assigned to that school WorkExpo won't allow this operation until you delete or re-assign all existing
student members of that school.
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A student may only be assigned as a member of one school only.

When printing documents for students, WorkExpo will default to using the registered school's details. Optionally
you can use the particular details of the specific school when printing for students assigned to that school. For
example, say that the registered school is Demo High and you have imported student records from Sample College.
When you print the Work Experience Arrangement form for students of Sample College, you can choose to use the
school details of Demo High School or Sample College.
As well as being able to import student records in the usual way, you can also import WorkExpo data files
from different schools. This may be useful if you want to merge WorkExpo data files from several different schools.
These files could be merged into a single large consolidated data file. Once this consolidated file had been
created you could print multi-school reports and gather Work Placement information for detailed analysis across a
range of schools.

To learn more about

See

Adding, editing and deleting school records.

Adding Editing and Deleting
Schools in WorkExpo (Section
9.3)

How to import data files into WorkExpo from several schools.

Importing data in WorkExpo
Multi Schools Edition (Section
9.7)

Dealing with schools that do not support WorkExpo.

Working with non-WorkExpo
schools (Section 9.11)

Working with the School data file and Multi-school projects.

School data files and Multi-school
projects (Section 9.7)

Generating statistical information from multi-school sources.

Generating statistical
information (on-line
documentation)

WorkExpo Multi School Edition is available as an upgrade from the regular edition.
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9.3 Add a New School
To add a new school in WorkExpo:
1.
2.
3.
4.
5.

From the WorkExpo main menu click the large options button.
In the School tab click the Add/Edit schools button. This opens the Add/Edit Schools dialog
Click the Add New Button.
Enter or edit the details of the school, including address and contact person.
You can choose to use these school details for students assigned to this school in forms and reports, otherwise
WorkExpo will use the main (registered) school's details.

You can also double-click the schools field in the Students window to add a new school.

9.4 Edit School Details
To edit a school record in WorkExpo:
1.
2.
3.
4.
5.
6.

From the WorkExpo main menu click the large options button.
In the School tab click the Add/Edit schools button. This opens the Add/Edit Schools dialog
Select the school by placing the cursor in the School name
Click the Edit Button.
Edit the details of the school as necessary.
You can choose to use these school details for students assigned to this school in forms and reports, otherwise
WorkExpo will use the main (registered) school's details when printing.

You can also double-click the schools field in the Students window to edit a new school or click on the
"School/College" label.

9.5 Delete a School
To delete a school in WorkExpo:
1.
2.
3.
4.
5.
6.

From the WorkExpo main menu click the large options button.
In the School tab click the Add/Edit schools button. This opens the Add/Edit Schools dialog
Select the school to delete by placing the cursor in the School name
Click the Delete Button.
Enter or edit the details of the school, including address and contact person.
You can choose to use these school details for students assigned to this school in forms and reports, otherwise
WorkExpo will use the main (registered) school's details.

If you want to delete a school and there are students currently assigned to that school WorkExpo won't
allow this operation until you delete or re-assign all existing student members of that school..

9.6 Delete Students By School
You can bulk delete students by a chosen school or you can choose to delete, say, all Year 10 students from a
particular school.
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To delete students by school and/or Year/Homegroup:
1.
2.
3.
4.

In the Students window from the Edit menu, choose Delete / Delete Students Wizard.
In the first page of the wizard, select the school from which you'd like to delete students.
You can choose to delete ALL students, a particular year or homegroup or selected students.
Click Finish and student records are deleted.

NOTES:
Deleting a student record also deletes all information associated with the student, including any
arrangements.
The Delete Wizard will display a count of any arrangements that will be deleted before changes are
committed.
Once the records are deleted they cannot be un-deleted.

9.7 Import Data Files - Overview
Importing WorkExpo data files from several different schools has the effect of combining the student, employer and
arrangement records into a single file. Using this single consolidated file you could print multi-school reports and/or
gather Work Placement information for detailed analysis across a range of schools.
Here are some things to be aware of when importing WorkExpo data files from other schools.
1. Before importing any school data file it's a very good idea to ensure that you have a good backup of your
current data file.
2. The information you import from a particular school data file is only as good as has been entered into that file
in the first place. For example, it duplicate records exist in the original then the consolidated database will
also contain duplicates.
3. Only the student, employer, arrangement and school details records are imported. No lookup tables
are imported, neither are any support tables containing information about visiting teacher lists, work
experience type lists, supervisor lists, student tracking, student preferences, student counselling, exit details
or user defined information.
4. When you import a school data file all student records imported with that data file are assigned as members
of the imported school. Of course you can change this once the records are imported.
5. Once the records have been imported and you try to re-import the same data file again WorkExpo will
warn you that the school's records have already been imported but will allow you to proceed if you
choose. This of course will lead to several duplicate records including duplicate arrangement records.
6. You cannot un-import a data file.
7. It is recommended that if you are dealing with a large number of schools you create a schools folder under the
WorkExpo data file folder. This will make working with the data file easier.
8. You can always create a new blank WorkExpo data file easily. Select File / New from the WorkExpo menu
bar. This create a blank empty data file and links to it, then opens it. If sample records records are not
required they can easily be deleted. Choose Delete Sample Records from the Tools / Utilities menu in
WorkExpo.
9. You can generate statistical information showing trends across a range of schools. See generating
statistical information (on-line documentation)
10. You can assign students as members of a particular school within WorkExpo. See assigning students to
schools (Section 9.10)

You cannot import school data files which themselves contain multiple schools.
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To learn more about

See

Adding, editing and deleting school records.

Adding Editing and Deleting
School Records in WorkExpo
(Section 9.10)

How to import data files into WorkExpo from several schools.

Importing data in WorkExpo
Multi Schools Edition (Section
9.9)

Dealing with schools that do not support WorkExpo.

Working with non-WorkExpo
schools (Section 9.11)

Working with the School data file and Multi-school projects.

Working with the School data file
and Multi-school projects
(Section 9.9)

Generating statistical information from multi-school sources.

Generating statistical
information from multi-school
sources ('Generating Statistical
Information' in the on-line
documentation)

9.8 Import School Data File
You can import WorkExpo data files from different schools. This may be useful if you want to merge WorkExpo data
files from several different schools. These files could be merged into a single large consolidated data file. Once this
consolidated file had been created you could print multi-school reports and gather Work Placement information for
detailed analysis across a range of schools.
To import a school data file into WorkExpo:
1.
2.
3.
4.

From the WorkExpo main menu choose FILE from the menu, then IMPORT.
Then choose import school data file.
Browse to the data file. This will have an .mdb (Microsoft Data Base) extension.
Click OK to import the file.

As an alternative to importing data files you can connect to a particular data file and open it. To do this, choose
File/Open from the file menu.
All student, employer and arrangement records are imported. In addition, the imported school's details are also
imported and the students are assigned as members of the imported school. However, no counselling, tracking,
EXIT, follow-ups or archive information is imported.

You cannot import school data files which are themselves multi-school data files.

9.9 Import School Data Files -Detailed Information
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You can import WorkExpo data files from different schools. This may be useful if you want to merge WorkExpo data
files from several different schools. These files could be merged into a single large consolidated data file. Once this
consolidated file had been created you could print multi-school reports and gather Work Placement information for
detailed analysis across a range of schools.

To learn more about

See

Adding, editing and deleting schools.

Adding Editing and Deleting
School Records in WorkExpo
(Section 9.3)

How to import data files into WorkExpo from several schools.

Importing data in WorkExpo
Multi Schools Edition (Section
9.7)

Dealing with schools that do not support WorkExpo.

Working with non-WorkExpo
schools (Section 9.11)

Working with the School data file and Multi-school projects.

Working with the School data file
and Multi-school projects

Generating statistical information from multi-school sources.

Generating statistical
information from multi-school
sources ('Generating Statistical
Information' in the on-line
documentation)

9.10 Assign Students to a School
To assign an Individual student to a school in WorkExpo:
1. From the WorkExpo main menu click the large Students button or click the Students button on the tool
bar.
2. In the Students window, click the Detail tab. (In older versions this was called the Background tab)
3. Select the school to assign from the School/College dropdown box
To assign Multiple students to a school in WorkExpo:
1. From the WorkExpo main menu click the large Students button or click the Students button on the tool
bar.
2. In the Students window, click the Detail tab. (In older versions this was called the Background tab)
3. In the School/College dropdown box, double-click to bring up the Add/Edit schools dialog box.
4. Click the Assign Students button to start the Assign students wizard.

You can also start the Assign Students wizard from the Schools Tab in the Options dialog.

9.11 Non WorkExpo Schools
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If you wish to import data from a non-WorkExpo school here are the options available to you:
1. Suggest that the school purchase, install and use WorkExpo.
2. Import the data manually record by record using your copy of WorkExpo.
3. If the data is stored electronically, you can contact Info Plan Software for a quote to re-work the file into a
WorkExpo readable format for import.
4. Click the "Send comments on this topic" link at the top right and include details of the requirements in your
message.
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Printing and Emailing

10.1 Email Documents for a Single Student
You can now send emails for an individual student and attached any or all available documents. The email can be
sent to the employer, student or the parent or a combination of all. Documents no longer need to be previewed
before being sent.
In the Print Wizard (or in the Quick Print dialog available in the Arrangements screen) you can now select 'Email'
rather than Print or Preview. (See image below)

To send an email with attached documents, follow these steps:
Select the document or documents you wish to attach to the email by selecting the check-boxes.
WorkExpo finds the email addresses for employers, students and parents and displays them in the Email
Options... dialog.
You can choose who to send the email to as the Send-To and, if necessary, who to include in the CC or
BCC fields.
If the employer and or student/parent email addresses are not found, you can add them on-the-fly without
the need to swap back and forth between various screens.
Simply add the email address by selecting EDIT... and make your changes. WorkExpo will use and update
that email address for that contact in the database.
Finally, click EMAIL.
Please note that you cannot use this email feature when sending a document to multiple employers or multiple
students, as that would require multiple email messages (possibly with multiple attachments) to be generated on
your system.
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Click 'Email Options...' to specify who to send the email to.

Select recipients by placing a check mark next to the recipient name (shown above) and select SAVE AND CLOSE
You can click the orange EDIT... link to add or edit the email address detail and other details can be edited from
here.
Click the top Edit... link to edit Employer details or click the lower Edit... link to edit student/parent details.
Note that the Subject and Body Content have been left blank above.
Your notes here:
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Click SAVE & CLOSE to save your changes.
After you click EMAIL, the email is ready to be previewed and checked before sending.
If you leave the SUBJECT blank, then WorkExpo will automatically generate a subject as follows:
Work Experience: Student Name - Date Range
If you leave the body text blank, WorkExpo will use the content from the Letter To Employer otherwise it will use
your custom body content.
You can edit the subject header and body content by clicking 'Email Options...' blue hyperlink on the documents to
select page of the Wizard.
Your notes here:
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Note that the content of the email is the content of the Letter to Employer. If you wish to change this content
you can.
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10.2 Email Arrangement Form
You can email the work experience and SWPL arrangement forms (or the Student Placement form in NSW) from
within WorkExpo.
Please note the following points:
1.
2.
3.
4.
5.
6.
7.
8.

You can only send one email at a time for an individual student.
You can send via Outlook, GMail or a remote mail server e.g. Bigpond.
If you send using Microsoft Outlook then before sending you can preview and edit the message.
You can set email preferences and setting from the OPTIONS / MISC tab or directly from Print Preview
window.
The employer the email is to be sent to is displayed at the top of the Email Settings dialog when in Print
Preview.
Only the Arrangement forms can be emailed. However, all other WorkExpo documents and lists can be
saved in PDF format.
If an employer has an additional email address for a postal contact, then the email is sent to the postal
contact and cc'd to the other.
Emails can only be sent in text format.

To send a copy of the Arrangement form attached as a PDF document to an email follow these steps:
Select an individual student from the list in the Print Wizard - Individual Student and click NEXT.

It is important that you select an individual student for email. You cannot select groups of students for email.
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Choose the Arrangement form option for the currently selected student.

and select PREVIEW then click FINISH
The document displays in print preview mode. You will notice the email options on the toolbar. Before you can send
emails for the first time you will need to check your email settings. Click Email Settings on the toolbar.

The Email settings dialog is displayed.
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You will need to configure your preferences for emailing here but you will only need to do this once.
Your name and title as the logged-in user will be displayed. Note that you can only send emails as the logged-in user
and not as the Main Contact for the school. This is due to password security issues.
Here are the settings you can configure:
Email Mode: Select the method or mode by which email messages will be sent from your machine. Select either
'Outlook', 'GMail' or 'Remote Server'. If you select Outlook then your Outlook email client will handle most of the
work and you will be able to preview the email before sending by checking the 'Display Outlook Email Before
Sending' option. You cannot add, edit nor delete entries in this list. These are the only options for email servers in
WorkExpo.
Use Outlook Signature: In Microsoft Outlook you can store your signature text to append at the end of emails.
Select YES and enter the name of your Outlook signature to add to the end of all emails sent.
Use Outlook Name: The name of your Outlook signature. Select from the drop-down box or leave blank. You
should not enter free-form text here. If you want to add a signature do that in Microsoft Outlook first.
Default Subject: The default subject of your email message. If you leave this blank WorkExpo will automatically
create a header containing the Arrangement type, the name of the student and the dates. e.g 'Work Experience - Joe
Bloggs - 12/12/2013 - 22/12/2013'. Alternatively, if you enter your own default subject header, WorkExpo will not
create a header.
Default Body: The default body text of your email message. If you leave this blank WorkExpo will use your default
'Letter To Employer' boilerplate text depending on the Arrangement type for the current student. If you enter your
own default body text, WorkExpo will not create body text.
SMTP Server: The name of the SMTP server to use if you have chosen 'Remote Server' as the email mode. e.g.
mail.bigpond.com
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SMTP User-name: The name of your existing account on the SMTP server. If you do not have an existing account,
then use a different email mode or save the document to PDF format and email manually.
SMTP Password: The name of your existing password on the SMTP server.
GMail Address: The name of your existing Gmail email address, e.g. JoeBloggs@gmail.com
GMail user-name: The name of your existing Gmail user-name, usually your Gmail email address name portion,
e.g. JoeBloggs
Gmail Password: The name of your existing password on Gmail.
Note that you can see the SEND TO email address in the TO: box just below your name in the dialog box
header.

Click to confirm send. If you have checked 'Display before sending' then you can preview the email.
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Click SEND

Only the Arrangement form, the SWPL form and the NSW Placement form can be emailed in this way.
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10.3 Print Work Experience Arrangement form(s)

What to do

Notes

1. With the WORKEXPO main
menu on your screen click on the
PRINT button.

WORKEXPO can print on the official department forms or print a facsimile.

2. The Print Wizard dialog box will
appear. You can choose to print an
arrangement form for an individual
student or a group of students.
In this example we will print for a
group of students.
Select the print for “several
students…” option
Click NEXT

3.
Select “WE Arrangement
forms” and click NEXT
4.

Select students

5.
Select to print on official
department forms.

You can select students by date or alternatively print forms for all students in
WORKEXPO
Do this by clicking “I want to print on official department forms”. Choosing
this option will print data only, so that you print on the official forms.

6.
Choose Preview or print and
click FINISH

10.4 Sample Documents
WorkExpo can generate the following documents.
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Employer report form
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Work experience arrangement form

WorkExpo User Manual

You can print all these documents directly from WorkExpo.

10.5 Letter Sample

©2020 Info Plan Software. All Rights Reserved.

78

WorkExpo User Manual

10.6 Certificate (Student)
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10.7 Statistics Sample

©2020 Info Plan Software. All Rights Reserved.

80

WorkExpo User Manual

81

10.8 Letter Setup and Margins
You can change the setup of letters and documents in print preview mode.
1. Select the letter (or document) you wish to change and view it in Print Preview
2. In print preview mode, click the FILE menu and choose PAGE SETUP
3. In the MARGINS tab choose smaller or larger margins to move the letter around on the page as necessary.

Letters in WorkExpo *do not* word wrap. So if you make the LEFT margin wider or the RIGHT margin wider
then check that the body text is not being truncated which may occur.

10.9 Troubleshoot - Printer Prints Blank Page
When printing the work experience arrangement form or the student certificate sometimes the printer may print a
blank page.
If the student or employer certificate is generating two pages - the certificate on the first page and a blank second
page, then your printer has not been set to Australian A4 size paper. All printers are initially set to American "Letter"
size paper which is shorter than Australian A4. The blank page is your printer trying to fit the invisible bottom
margin of page one onto a second page.
To fix this problem have your school's IT support person change the printer setup to A4 size.
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10.10 Print Wizard
Use the Print Wizard to print:
Multiple documents for an individual student.
Multiple copies of a single document for multiple students.
Lists and Reports.
Documents for Visiting Teachers.
Work Experience Arrangement Forms.
Statistics relating to work experience.
Mailing labels for employers.
Blank work experience arrangement forms.
Student and employer certificates.
Custom one-off letters to employers.
...and more
How to start the Print Wizard:
Click the large Print button on the main menu OR
Choose Print Wizard from the File menu.
Sorting and filtering results using the Print Wizard:
You can sort the results in the Print Wizard by choosing the sort order on the last page of the wizard.
You can specify a particular year level or homegroup or use a custom group (Section 5.18).
You can use date parameters in many reports.
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The Print Wizard gives you the most options when it comes to printing from WorkExpo.

10.11 Employer Evaluation Form
You can edit the criteria items in the employer evaluation form.
1.
2.
3.
4.
5.

Start WorkExpo and go to the Main Menu.
Click the large OPTIONS button on the Main Menu.
Click the "General" tab.
Click the "Edit Criteria Items in Employer Evaluation form" link. (Highlighted in blue).
There are 2 separate sets of criteria items. One for "work experience placements and another set for non-work
experience placement e.g. VET, VCAL
Edit the criteria item(s) here.

NOTE: You are not able to add or remove the number of criteria items but they *all* can be changed. You
able not to change the overall layout of the document.
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Import and Export

11.1 Troubleshoot importing records
Follow these steps to troubleshoot problems when trying to import records into WorkExpo from a Microsoft Excel
spreadsheet.

Possible
problem

Resolution

Column
missing

In Microsoft Excel check that all required columns are present. If a column is missing then the
import will fail.
More Detail:
The required columns are FirstName, LastName, DateOfBirth, Form, Homegroup, Street, Suburb,
Postalcode, ParentName, ParentPhone and Note. All columns must be present including
HomeGroup even if your school does not have homegroups. In this case, include the Homegroup
column and column header but leave the column itself empty. Also ensure that columns are in the
correct sequence as in the above list.

Header
missing
or not
spelled
correctly

Check that all headers are correctly spelled with no spaces in any of the header names.

Hidden
column or
row within
the data

Check that there are no hidden rows or hidden columns in your spreadsheet. Hidden rows or hidden
columns within the data will cause the import to fail.

More Detail:
Ensure that that there are no spaces in *any* header row name. The header row must always be Row
1. Compare the spelling of header row names with the following: FirstName, LastName,
DateOfBirth, Form, Homegroup, Street, Suburb, Postalcode, ParentName, ParentPhone and Note.

More Detail:
Select the data area in your spreadsheet by choosing Select All from the Edit menu. Then from the
FORMAT menu choose Column then Unhide. Then from the FORMAT menu choose ROW then
unhide. Now deselect the data area and check if there are any empty rows in the data area or empty
columns. If so delete these empty columns by selecting the column to delete and choosing DELETE
from the EDIT menu.

Hidden
In Excel check that there are no columns to the right of the last data column (NOTE) containing
data in
blank information.
spreadsheet
More Detail:
If there is hidden data anywhere in the spreadsheet even in columns outside the data area the
import will fail. Try deleting several columns to the right of the last column (Usually the NOTE
column). To delete these columns select the entire columns by clicking on the column headers and
dragging to include several columns. Then choose DELETE from the EDIT menu. Save the
spreadsheet and try again. Also check for rows below the last data row in the spreadsheet.

File format
conflict

WorkExpo is a Microsoft Access database. There may be file format and version issues depending on
the configuration of your machine and the version of Microsoft Excel you have. In this case save the
spreadsheet in an earlier version of Microsoft Excel.
Save your spreadsheet as an Excel 5.0/95 spreadsheet.
More Detail:
Systems are backwards compatible in Microsoft Office. Try saving the spreadsheet in Microsoft
Excel version 5.0 format. To do this within Excel choose FILE then SAVE AS and in the Save As
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Type drop down box choose Microsoft Excel 5.0/95 workbook. Then try importing again.

Corrupt
workbook

The workbook may be corrupt. If all else fails, create a new blank spreadsheet and copy and paste
the selected data records into the new spreadsheet.
More Detail:
When you export from your school's database system into Microsoft Excel sometimes additional
unnecessary macros and code modules are also exported and these may interfere with the import
process. Open the spreadsheet containing the data you wish to import. Select ALL, then choose
COPY. Create a new workbook and paste the data into the new workbook. Save then new workbook
and try importing from this new file.

Error
message

You are getting the error message Field'ROW1'doesn't exist in the destination table
'tblImportHeaders'

Field ROW1
When school data is exported to Excel it sometimes exports a "ROW1" column as the last column in
doesn't
the spreadsheet. This column is hidden but if you check the column headers you will notice that the
exist.
sequence is missing a letter of the alphabet.
Check the column to the right of the last data column and unhide it. Choose Format Column Unhide
to see the hidden column. Remove this column completely by selecting the entire column and
choosing Delete from the Edit menu.

11.2 Import Employer records
Import - employersYou can import employer records into WorkExpo from any external electronic system.
You must, however, do this as a 2 step process.
Export the required records from your system to an Excel file in .xls format
Import this file into WorkExpo by choosing Tools / Wizards /Import wizard
Select Import Employer records option from the Import wizard.
Follow the Import Wizard's instructions on screen.

Export employer records to an XLS spreadsheet, then use that spreadsheet as a template for your import.

EMPLOYER FIELDS (Full List)

BusinessName
ContactSalutation
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ContactFirstName
ContactInitial
ContactLastName
EmplAddress
EmplSuburb
EmplPostalcode
EmplWorkPhone
EmplFaxPhone
EmplMobilePhone
TypeOfWE
EmplNote
StateSchool?
LetterName
ReservedText
ReservedDate
ReservedBoolean
ReservedNumber
EmplMailAddress
EmplMailSuburb
EmplMailPostalcode
EmplEmail
EmplWebSite
EmplIndustrySector
EmplIndustrySectorSub
EmplSize
EmplStatus
EmplAttend
EmplWorkSafety
EmplDress
EmplMultiSite
EmplOther
EmplDateCreated
ContactTitle
UserDefinedE1
UserDefinedE2

©2020 Info Plan Software. All Rights Reserved.

86

WorkExpo User Manual
UserDefinedE3
UserDefinedE4
UserDefinedE5
EmplStartTime
EmplEndTime
EmplRate

Export employer records to an XLS spreadsheet, then use that spreadsheet as a template for your import.

11.3 Update Import
You can import student records into WorkExpo on a conditional basis using a update import. This is useful when
you want to update records from your central school database rather than replace them.
Here's how a update import of student records works:
1.
2.
3.
4.
5.

The initial import process is identical to a normal import of records.
On the last page of the Import Students wizard you flag the Update Import check box to true.
Any new student records not found to currently exist in WorkExpo are imported in the normal way.
For found existing student records the update import wizard updates the student details only.
Any changed address or contact information is updated for the existing student, all other details are
untouched.
6. WorkExpo will look for a match on your school's StudentID field to determine an existing record.
If the StudentID field is empty, the Import wizard will look for a match on first name, last name and date of
birth.

11.4 Import signature images
Letters which appear in WorkExpo, including the letter to parent and letter to employer can have your signature
embedded in the document.
This will save you time if there are multiple letters to sign. The format of the signature must be a image format
(Bitmap .bmp)
Check the WorkExpo CD for a sample signature image file called UserSig.bmp in the ..Manual Install/Common
folder
You can use Windows PAINT program to view your image file before saving.

©2020 Info Plan Software. All Rights Reserved.

87

WorkExpo User Manual
Follow these steps to import your signature into WorkExpo:
1. Sign your signature on a small piece of paper.
2. Scan the signature and save it as a Windows bitmap file (.bmp)
3. Save the file in MS PAINT as a Windows Monochrome bitmap.
4. The image size should be about 1.76 cm wide by about 1.00 cm tall
or about 200 x 100 pixels. In PAINT choose IMAGE / ATTRIBUTES to check the size.
5. Save the file with a .bmp extension.
6. Start WorkExpo and click the “Options” button from the main menu.
7. Click the “Signatures” tab.
8. Select signature being imported – either teacher or principal.
9. Enter the path and filename to the signature.
10. Click the “Import Signature” button.
Check the available options under “Use/Include signatures” . WorkExpo stores the signature internally in the
database for future use.
You can also export a signature file, if necessary, from WorkExpo.
You may wish to do this to check if the signature is correct.

11.5 Exporting
You can export from WorkExpo. Use the Export wizard for best results.
To start the Export wizard choose Export from the File menu.
Also be aware that all data for WorkExpo is stored in a single file, by default:
c:\program files\workexpo\data.mdb
If you have a copy of Microsoft Access you can open this file directly and copy and paste rows from the tables.
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Backup and Restore

12.1 About The Data File
The single file DATA.MDB is the most important one as far as WorkExpo is concerned. This single file contains
ALL your WorkExpo information including:
School details
User details
Teacher information
Employers
Students
Everything Else
If you look in the WorkExpo folder on your hard drive you will see several files which together make up WorkExpo.
However, all these files are replaceable except for one: DATA.MDB
It is important to be aware at all times where you WorkExpo data file is. How can you find out? Here are a few
different ways:
Click the yellow light bulb a few times and it will tell you the name and path of your current data file.
From the Main Menu in WorkExpo, click the Options button and then click the Data File tab.
Using Windows Explorer you can navigate to the WorkExpo folder (c:\program files\workexpo) and see
the Data file. In a network environment it may not be there but rather in a shared network drive on a file
server.
It is recommended that you turn on the data file path reminder feature in WorkExpo. Here's how:
1. From the Main Menu in WorkExpo, click the Options button and then click the Data File tab.
2. Place a tick in the box "Show the WorkExpo data file path in the title bar"
3. WorkExpo will now always remind you which data file you are currently using and connected to.
Why is it so important to know about the data file?
It is important because you may have more than one data file on your system. You need to aviod confusion else you
may be writing records to an old or out-of-date file.

12.2 Automatic Multiple Backups
WorkExpo can create multiple backups of the data file. This means that if you save a bad data file, you still have
other good backups from which to retrieve data from in case of an emergency. WorkExpo will append the day of the
week to each file name so you have will have up to seven backups at any one time. This setting is optional.
To turn on multiple backups:
1. From the Main Menu click the Options button
2. Click the Backup tab
3. In the backup options place a tick in the box for Automatic Multiple Backups.

Each backup will have the day of the week appended to the file name creating up to seven backup copies of the
data file.

12.3 Backup Data File
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IMPORTANT NOTE: You should regularly back-up your data.
Your data file stores all information you enter into WorkExpo. The default file name is DATA.MDB
This file by default is located in c:\program files\workexpo\data.mdb
To backup this file you can copy it using Windows Explorer tools or WorkExpo can create backups for you.
Follow these steps to backup your WorkExpo data file:
1. From the WorkExpo main menu choose the large Options button.
2. Click the Back-up tab.
3. The Backup Options dialog box will be displayed.

4. In the File To Be Saved box enter the DATA.MDB file and its path. This is the file which stores all your
WORKEXPO data, including student, employer and arrangement data.
5. In the Save As box enter the location and name of the backup. The location must pre-exist on your system but
the name for the Save As backup file can be new. You can also choose to be reminded to backup on close.
6. Click CLOSE or press ESC to close off the dialog box and save changes.
NOTES:
Remember that ALL your data is stored in a single file - DATA.MDB If you have a reliable recent backup of
this file you can completely restore WorkExpo with a minimum of fuss.
It is recommended that you backup to a network location. This is typically the most secure form of backup.
You can tell WorkExpo to prompt you to backup when exiting the program. You can also restore from a
previous backup. Click the restore tab.
Also be aware that you can browse and use an existing data file. Choose Open from the File menu.

WorkExpo will also automatically save a daily copy of each backup for each day of the week in the same folder
you nominate. Optionally you save multiple copies of the file. Check the Automatic Multiple Backups tab in
the Options dialog.

12.4 Backing up to a CD
You can backup to CD if you are using Windows XP and you have a CD Burner installed. If you are using Windows
2000 or earlier versions of Windows you will get a message which says "You cannot save in the folder you specified"
when you try to point to the CD Rom drive as the folder to save in.
Of course, if you don't have a CD burner installed you can't backup to CD.
Follow these steps to backup your WorkExpo data file to CD under Windows XP.
1. In WorkExpo go to the Main Menu and click the large Options button.
2. Click the Backup tab
3. In the Save as box enter the path to the CD Rom drive or click the Browse button and navigate to the CD Rom
drive.
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4. Enter a File Name to save as e.g. DataBackupFriday.mdb
5. Then click the Backup Now button.
6. WorkExpo will tell you that the backup is successful, but what has happened is that Windows has copied the
file to a temporary folder on the C: drive as C:\Documents and Settings\<Username>\Local
Settings\Application Data\Microsoft\CD Burning
7. Next a pop-up window in the bottom right corner of Windows will appear.
8.

This will offer to burn the file to a CD ROM. Of
course, you must a CD Burner installed to use
this feature.
Finally, click on the message balloon to start the Windows CD ROM burning wizard and follow the instructions.
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Archiving

13.1 Archiving Records And End Of Year Rollover

What to do

Notes

1. With the WORKEXPO main
menu on your screen click the
TOOLS menu then choose
WIZARDS then ARCHIVE wizard.

WORKEXPO can archive student records, employer records or arrangement
records. This helps maintain your database.

2. The Archive Wizard dialog box
will appear. You can choose to
archive arrangement records,
student records or employer
records.
In this example we will archive
student records.
Select “Work Experience
Arrangement records”
Click on the NEXT button...

3.
Select the records you wish to
archive in the box.
4. Click ARCHIVE

WORKEXPO archives records by form or year level group.
Your records are now stored in an archive. You can browse the archive at any
time by clicking the ARCHIVE button then selecting “I’d like to browse the
archives”
NOTE: Records can be restored or deleted from the archive.

13.2 Archiving Records
WorkExpo provides three separate methods for archiving your data.
The Archive Wizard.
Advanced Archiving.
The End-Of-Year Rollover wizard
Each of these methods has pros and cons and depending on your situation you may choose one method over the other becuase it suits the
way you work and your particular requirements.
The most efficient and effective way to archive your data is to always archive your arrangement records first.
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Then archive student or employer records as a second step. This means that if you wish to restore at a later stage you can restore the
student and employer records first, then restore the arrangement record. If you try to restore an arrangement record without first
restoring the corresponding student or employer record you will delete the arrangement record rather than restore it. This is because an
arrangement can't exist without both related student and employer records.
The automatic archive wizard will always archive records in the correct order so that there's no likelihood of losing data.
You should archive all arrangement records for a period of at least five years. You can always print a copy of an archived
arrangement record even if you have deleted the relevant student and employer records.
Consider archiving student records for a period of one to two years before deleting them.
Consider archiving employer records who no longer offer work experience placements or for some other reason are no longer
part of the program.
You can restore, delete or print an archived arrangement record once in the archive.
Archived records can be restored or deleted from the archive. Once deleted from the archive they cannot be restored.
Archived records are part of the file Data.mdb. When you save or backup this file you will also be backing up your archives.
Double-clicking on any archived record in an archive will show details for the record in addition to further options.

Arrangement records: First Into the Archive - Last Out of the Archive.

13.3 Archive Or Delete
In general terms you should archive records rather than delete them. Why?
By archiving records you have a permanent record of past programs.
You can print an arrangement record for a past student if the record has been archived.
You can compare past programs with present day programs.
Archiving records allows you to undo (or "un-archive") the record if you make a mistake.
You can delete records directly from the archive if necessary.

13.4 Auto Archive
You should archive your data so that you may refer to it in the future if necessary. At the end or beginning of a year is
the usual time to archive your data. The Auto-Archive wizard will archive your data and clean out your student and
arrangement windows.
What does Auto-Archive do?
Automatically archives all student records and all arrangement records within the WorkExpo data file.
Empties the records from both the students and arrangements windows so that these areas are ready for
new records.
This means that after auto-archiving there will be 0 students and 0 arrangements in the main system.
You can view and or restore your records once archived. See Restore Archives (Section 13.8)
You can view the archives at any time by selecting ARCHIVES from the VIEW menu.
Are there any alternatives to Auto-Archive?
Yes, you can archive your records using the archive wizard instead. See the Archiving (Section 13.1)
records tutorial.
Alternatively you can archive your records using a file-based approach. See File-based approach to
archiving records.
Another options is to archive arrangement records only and roll over the student records by performing an
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13.5 Archive Data Sheet View
You can view Archives in DataSheet view from the Archives window. Click the View Datasheet icon on the toolbar
and the Datasheet view is displayed.
To sort the Datasheet grid:
1.
2.
3.
4.

Place the cursor in the column you'd like to sort on
Right click for the shortcut menu
Choose sort ASC or DESC
The Datasheet is now sorted by the selected field.

To filter the Datasheet grid:
1.
2.
3.
4.

Place the cursor in the column you'd like to sort on
Right click for the shortcut menu
Choose sort Filter By Selection
The Datasheet is now filtered by the selected field value.

OR use the options in the drop down box at the top of screen.
To print the Datasheet grid:
1. Sort and/or filter the Datasheet as necessary
2. Click the Print button
3. If your settings are set to Print Preview the report will show first in preview.
To copy the Datasheet grid:
1. With the Datasheet grid on screen, press CTRL + A to select all
2. Open Microsoft Excel
3. Choose Edit / Paste to paste the contents into Excel.

13.6 Browse Archives
1. From the TOOLS/WIZARDS menu select "Archive Wizard".
2. Select the "Browse" option.
3. In the archive browse window, double-click a record to view detail for that archived record.
OR
From amywhere withing WorkExpo from the View menu, choose Archives.

You can restore an individual archived record by clicking the restore button on the detail record dialog.

13.7 Print Archived Arrangement
HOW TO PRINT ARCHIVED ARRANGEMENT RECORDS
1. Go to the archive browse window.
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2. Then select the the record by double-clicking it.
3. Click the "Print" button.

13.8 Restore Archived Arrangement
You can restore an archived arrangement record. Here's how:
1. Go to the archive browse window.
2. Then select the the record by double-clicking it.
3. Press the "RESTORE" button.
If you want to restore ALL records press the RESTORE ALL button.
NOTE: Be aware of the problems of restoring archived arrangement records. Tell me more... (Section 13.2)
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Reference

14.1 Getting Help

What to do

Notes

With the WORKEXPO main menu
on your screen click on the HELP
menu at the top of the screen.

WORKEXPO has its own built-in on-line Windows help files.

Select CONTENTS from the dropdown menu.
Click on the topic heading to move
to that topic.

Topic heading appear in green and are underlined.

You can also select SEARCH to
search for information on a
particular topic.

If you are unable to find a topic select CONTENTS and click on “What I want
is not listed”. This displays a range of further options.

14.2 Keyboard Shortcuts

To do this...

Keyboard Shortcut

To move from record to record

Page Up or Page Down

Zoom in a text box

SHIFT & F2

To move from field to field

TAB (Forward) SHIFT + Tab (Backwards)

To move from tab to tab in a tabbed dialog box

CTRL+Tab

Close Print Preview

ESC

Close a dialog box

ESC

Undo a record

Press Esc twice

Close a window

CTRL+W

To show the Windows print dialog box

CTRL+P

To open a drop-down list

F4

To tick an item in a tick box

Spacebar

To select the record number

F5

CUT

CTRL + X
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COPY

CTRL + C

PASTE

CTRL + V

14.3 Mouse Shortcuts

To do this...

Mouse Shortcut

Select an item in a list

Double-click on name

To sort records

Right-click and select Sort Ascending or sort descending

To filter records

Right-click and choose filter by selection

To remove filter or sort

Right-click and select remove filter/sort

To cancel a button that appears on
the screen after pressing it.

Slide the mouse off the button then release the left mouse button

Most of these shortcuts are use in many Windows programs.

14.4 Using Multiple WorkExpo Data Files

Follow these steps

How do I do this?

1. Start WINDOWS EXPLORER

Windows Explorer is the Windows File Management Tool that will
help you get the most out of WorkExpo.

2. Navigate to the WorkExpo folder

The default path is C:\Program Files\WorkExpo

3. Create a new folder below the

Choose FILE then NEW FOLDER from the Windows Explorer file
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WorkExpo folder called “Files”

menu. Then name the new folder from it’s default name
”New Folder” to “Files”

4. Copy the file DATA.MDB from the
WorkExpo folder to the WorkExpo/Files
folder.

This will close the Options Dialog box and return you to the Main
Menu window.

5. Start WorkExpo and linked back and
forward between the two data files.

In WorkExpo choose OPEN from the FILE menu, navigate to the data
file and click OK. WorkExpo will link to that file and remember it next
time you start.
You now have two WorkExpo data files. This can be useful if you need
to make changes but worry about making mistakes. You can also use
this method as an alternative to archiving.

14.5 What Teachers Say About WorkExpo
'Thank you for the fantastic WorkExpo training session yesterday. I thought it was very well run, informative and
enjoyable - the most useful professional development I have done!
Kasia Kinsky, Careers Counsellor, Camberwell Girls Grammar
'I have been a satisfied customer of WorkExpo for five years now. WorkExpo continues to get better and better.'
Nigel Murray, Cleeland Secondary College
'I have been doing wonderful things with WorkExpo and I think it is fabulous!'
Kerri Farrell, Copperfield College
'I've found WorkExpo to be a lifesaver. Over 100 students took up optional work experience this year so it saved
me lots of time. Very user friendly.'
Julie Ripon, Careers Advisor, Gippsland Grammar
'As a fairly ordinary computer user I found WorkExpo very easy to learn and use. It has the NSW forms and
documents as an option. I highly recommend it! A lot of work has been done to make this software idiot-proof!'
Brian Dean, Eden-Marine Technology College (NSW)
'May I thank you for both your products and your service, they have been tremendously valuable in assisting me
in my work.'
Peter Astin, Mazenod College - Mulgrave North, Victoria
'The new additions are fantastic. I will document all interviews using the counselling section rather than keep a
separate written record.'
Mark Paynter, Marist-Sion College
'The best bit of software I've ever bought!'
Melinda Savino, Nazareth College, Noble Park
'I’ve used several work experience software programs, but WorkExpo is definitely the best!'
Jacqui Dods, Billanook College
'WorkExpo prints out my arrangement forms in a snap!'
John Frawley, Rowville Secondary College
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'I’ve been using the WorkExpo software for some time now. I don’t know how I managed without it'
Lainie Carroll, Mount Waverley Secondary College
'Without WorkExpo there is no way in the world that I would have managed all the paperwork for sending 263
Year 10 students out on block release for two weeks.'
Judith Clarke, St. Monica’s College, Epping - Victoria
'Indispensable! Can't live without it. Especially like the block list report WorkExpo generates. Gives me a complete
overview of my block.'
Charles Hogarth, Our Lady of Sion College, Box Hill
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Technical & Support

15.1 Data File Overview
All the information that you enter into WorkExpo is stored in a single data file.
It's default name is Data.mdb and it normally resides in the C: \Program Files\WorkExpo folder. This file contains
all your important information and should be carefully backed-up regularly.
WorkExpo can create multiple backups of the data file. This means that if you save a bad data file, you still have
other good backups from which to retrieve data from in case of an emergency. WorkExpo will append the day of the
week to each file name so you have will have up to seven backups at any one time. This setting is optional.
To turn on multiple backups:
1. From the Main Menu click the Options button
2. Click the Backup tab
3. In the backup options place a tick in the box for Automatic Multiple Backups.
Each backup will have the day of the week appended to the file name creating up to seven backup copies of the data
file.
Backup
It's a good idea to have two or more copies of your data file in case one is lost or unusable. WorkExpo has an
option to do this for you automatically. See Automatic Backups (Section 12.2).

15.2 Troubleshooting
15.2.1 Trouble Shooting FAQ

What to do if:

Notes

1. Dates don’t seem to work
properly in WORKEXPO.

Go to WINDOWS utility CONTROL PANEL and select REGIONAL
SETTINGS. Make sure that AUSTRALIAN date formats are set. You may
need to check TIME/DATE. Set your WINDOWS time/dates defaults as:
dd/MM/yyyy

2. Pages don’t seem to print
properly.

Go to WINDOWS utility CONTROL PANEL and select PRINTERS.
Select the Printer Properties.
Make sure that the paper size A4 is the global default setting in
WINDOWS.

3. Some paragraphs seem to be
Make sure that A4 is your standard paper size in WINDOWS. (See above) If
overprinting onto other paragraphs. the problem persists then preview the problem document in WORKEXPO
then select PRINT SETUP from the file menu and adjust the margins
manually.
4. WORKEXPO is not calculating a
student’s AGE properly

Go to WINDOWS utility CONTROL PANEL and select REGIONAL
SETTINGS. Make sure that AUSTRALIAN date formats are set. You may
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need to check TIME/DATE. Set your WINDOWS time/dates defaults as:
dd/MM/yyyy
5. My DATA.MDB file is too big to
fit on a floppy disk

You should backup the data file to a memory stick or a network folder.

15.2.2 Phone and Fax Issues
The phone and fax details are related to each WorkExpo logged-in user, not the school. This is by design as there can
be multiple users each with different phone and fax details.
To add/edit or delete phone and fax numbers:
1.
2.
3.
4.

From the WorkExpo Main Menu click OPTIONS.
In the School Details section you will note that there are no fields for phone or fax.
Click Add/Edit/Delete WorkExpo users.
Each user can have their own phone and fax details.

You can add, edit or delete phone, fax and mobile phone numbers here.
WorkExpo uses the phone, fax and mobile details of the current logged in user.
To change the logged in user without exiting WorkExpo:
1.
2.
3.
4.

From the File menu choose Log Off
From the login dialog box select the user from the drop down list
Enter a password if necessary.
You are now logged in as the selected user and WorkExpo will use the logged in user details in all documents
and letters.

15.2.3 Certificate Printing On Two Pages
The student and employer certificates are designed to print on one page only.
If the certificate is generating two pages - the certificate on the first page and a blank second page, then your
printer may not have been set to Australian A4 size paper.
All printers are initially set to American "Letter" size paper which is shorter than Australian A4.
The blank page is your printer trying to fit the invisible bottom margin of page one onto a second page.
To fix this problem have your school's IT support person change the printer setup to A4 size.
If you are using a school logo with the certificate it may be that you have set the paper length for the certificate too
long.
To fix this display the certificate in print preview mode then:
1. Click the Logo Settings button on the Print Preview toolbar.
2. In the Logo settings dialog box make sure that Extra Page Depth is set to 0 cm.

15.3 Subscription options
Standard single-user subscrption
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A single-user WorkExpo subscription includes:
12 months phone/email/remote desktop product support.
Unlimited access to the on-line support materials available on the Info Plan Software web site.
Critical bug fix updates of the software.
Telephone support.
Network/Multi-User Support (2 - 6 users).
A multi-user WorkExpo subscription includes:
Unlimited email based support for the duration of the multi-user subscription .
Unlimited access to the on-line support materials available on the Info Plan Software web site.
Critical bug fix updates for the duration of the subscription license.
Telephone support for each member of the multi-user subscription .
Refund Policy
The refund policy is fully detailed in the End User License Agreement (Section 15.4) section. The following is
a summary:
Users must agree to the end-user-licence agreement before installing the software
An evaluation version of the software is provided upon request to allow users to evaluate the software
Users should fully evaluate the software before purchasing
The software is provided "as is". No guarantees or warranties are provided
Info Plan Software does not provide refunds once software has been purchased
Submitting Suggestions and Reporting Issues
If you wish to make a suggestion or report an issue you have discovered using WorkExpo, you can do so on-line or
by phone.
Alternatively, you can email Info Plan Software support at support@infoplan.com.au
The amount of information you can provide us with about the nature of a problem you are having will directly affect
our ability to resolve it.
The more information you can provide about your environment, the steps to reproduce and any other relevant
information the better.
Obtaining WorkExpo Updates
Click "You can download any updates available to you directly from the Info Plan Software web site at :
http://www.infoplan.com.au/workexpo

15.4 Subscription and Copyright
WORKEXPO - END USER LICENCE AGREEMENT AND COPYRIGHT:
=============================================================
By installing this SOFTWARE you have agreed to this license agreement when you clicked “I Agree” when you ran
the install wizard. By proceeding to install this SOFTWARE you have indicated your acceptance of all the terms and
conditions stated in this agreement.
This is a legal agreement between you (either as an individual or a single entity) and Info Plan Software for this
software product which includes computer software and may include associated media, printed materials, and
"online" or electronic documentation (the "SOFTWARE"). By installing, copying or otherwise using this SOFTWARE
you are agreeing to be bound by the terms of this agreement. If you do not agree to the terms of this Agreement, do
not install or use the SOFTWARE.
1 GRANT OF LICENSE. This agreement grants you the following rights.
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(i) EVALUATION LICENSE
You may install and use an unlimited number of evaluation copies of the SOFTWARE on an unlimited number of
machines.
(ii) SINGLE USER SUBSCRIPTION
You may install and use one copy of the SOFTWARE on a single computer. The primary user of the computer on
which the SOFTWARE is installed may make a second copy for his or her exclusive use on a portable computer. This
license is NOT transferable to any other person at any time. Only the person who purchased the SOFTWARE is
licensed to use the SOFTWARE.
(iii) NETWORK (MULTI-USER) SUBSCRIPTION
You may use as many copies of the SOFTWARE as your multi user license entitles you to, in the manner specified
above. You are also entitled to make a corresponding number of secondary copies for portable computer use as
specified above. Multi-user licenses are not transferable.
2. COPYRIGHT. The SOFTWARE is owned by Info Plan Software and is protected by copyright laws and
international treaty provisions, as well as other intellectual property laws and treaties. The SOFTWARE is licensed,
not sold. You must therefore treat the SOFTWARE like any other copyrighted material.
3. TERM OF LICENSE. The license will continue until you physically destroy all copies of the SOFTWARE and
merged portions thereof, and return any original program media and documentation to Info Plan Software.
4. OTHER RESTRICTIONS.
(i) TRANSFER OF LICENSE
You may not transfer, nor rent, nor lease nor share the SOFTWARE with any other person or co-worker. Each user
of the software must be licensed specifically. In the case of a multi-user licence, licensed users must be nominated at
the purchase date. Multi-user licenses may not be transferred, leased, rented or shared.
(ii) REVERSE ENGINEERING
You may not reverse engineer, decompile, or disassemble the SOFTWARE.
(iii) SEPARATION OF COMPONENTS
The SOFTWARE is licensed as a single product. Its component parts may not be separated for use on more than one
computer, or accessed in any way other than through the provided user interface.
(iv) TERMINATION
Without prejudice to any other rights, Info Plan Software may terminate this agreement if you fail to comply with
the terms and conditions of this agreement. In such event, you must destroy all copies of the SOFTWARE and all of
its component parts.
5. ENHANCEMENTS AND UPDATES. From time to time, at its sole discretion, Info Plan Software may provide
enhancements, updates, or new versions of the SOFTWARE on its then standard terms and conditions thereof. This
Agreement shall apply to such enhancements.
You may not remove any proprietary notices, labels, trademarks from the SOFTWARE or associated documentation.
You may not modify, de-compile, disassemble, reverse engineer or translate the software.
LIMITED WARRANTY
You assume all responsibility for the selection of the SOFTWARE as appropriate to achieve the results you intend
and for the installation of, use of, and results obtained from the SOFTWARE. Info Plan Software warrants that the
media on which you obtained SOFTWARE shall be free of manufacturing defects. Except for the limited warranty set
forth herein, the SOFTWARE is provided "AS IS" to the maximum extent permitted by applicable law.
Info Plan Software disclaims all warranties, either express or implied, including but not limited to implied
warranties of merchantability, fitness for a particular purpose, and non-infringement with respect to the
SOFTWARE and the accompanying documentation. Without limiting the foregoing provisions, Info Plan Software
makes no warranty that the SOFTWARE will be error-free or free from interruptions or other failures or and makes
no guarantee that the SOFTWARE will meet your requirements. The foregoing provisions shall be enforceable to the
maximum extent permitted by applicable law.
CUSTOMER REMEDIES. Info Plan Software and its suppliers' entire liability and your exclusive remedy shall be,
at Info Plan Software's option, either (a) return of the price paid or (b) repair or replacement of the SOFTWARE that
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does not meet Info Plan Software's Limited Warranty and which is returned to Info Plan Software with a copy of
your proof of purchase. This Limited Warranty is void if failure of the SOFTWARE has resulted from accident,
abuse, misapplication or misunderstanding the purpose of the software. Any such warranty period shall be at the
entire discretion of Info Plan Software but will not exceed a period of thirty (30) days from purchase date.
NO LIABILITY FOR CONSEQUENTIAL DAMAGES. In no event shall Info Plan Software or its suppliers be
liable for any damages whatsoever (including, without limitation, damages for loss of business profits, business
interruption, loss of business information, or other pecuniary loss) arising out of use of or inability to use this Info
Plan Software product, even if Info Plan Software or its dealer have been advised of the possibility of such damages.
Some countries do not allow the exclusion or limitation of certain implied warranties or the limitation of the
foregoing warranty or the exclusion or limitation of incidental or consequential damages, in which case and to the
extent such exclusion or limitation is not allowed some of the foregoing limitations and exclusions may not apply to
you.
HIGH RISK ACTIVITIES. The SOFTWARE is not fault-tolerant and is not designed or intended for use in
hazardous environments requiring fail-safe performance, including without limitation, in the operation of nuclear
facilities, aircraft navigation or communication systems, air traffic control, weapons systems, direct life-support
machines, or any other application in which the failure of the SOFTWARE could lead directly to death, personal
injury, or severe physical or property damage (collectively, "High Risk Activities"). Info Plan Software expressly
disclaims any express or implied warranty of fitness for High Risk Activities.
GENERAL PROVISION. You shall have no right to sub-license any of the rights of this agreement, for any reason.
In the event of the breach by you of this Agreement, you shall be liable for all damages to Info Plan Software, and
this Agreement shall be terminated. If any provision of this Agreement shall be deemed to be invalid, illegal, or
unenforceable, the validity, legality, and enforceability of the remaining portions of this Agreement shall not be
affected or impaired thereby. In the event of a legal proceeding arising out of this Agreement, the prevailing party
shall be awarded all legal costs incurred.
This Agreement constitutes the entire agreement between the parties for the supply of the SOFTWARE and its
associated documentation and supersedes all prior arrangements, agreements, representations, and undertakings.
This Agreement may not be changed or modified except by a written instrument duly executed by each of the parties
hereto.
MISCELLANEOUS. This Agreement shall be governed by and construed in accordance with the laws of Australia,
without reference to conflict of laws principles. If any provision of this Agreement is held invalid, the remainder of
this Agreement shall continue in full force and effect.
ACKNOWLEDGEMENTS. You acknowledge that you have read this Agreement, understand it, and agree to be
bound by its terms and conditions.
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